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Copyright and Trademark Notices
Copyright   1998–2006 The Amanda Company. All Rights Reserved. This guide and the 
software described herein are copyrighted with all rights reserved. No part of this 
publication may be reproduced, transmitted, stored in a retrieval system, or translated into 
any language in any form by any means without the prior written permission of The 
Amanda Company.

Amanda and Amanda@ are registered trademarks and sales trademarks of The Amanda 
Company. Other brand names and product names are trademarks or registered trademarks 
of their respective owners.

Limited Warranty on Software
The Amanda Company warrants the media on which the software is recorded to be free 
from defects in materials and faulty workmanship for a period of 90 days from the date the 
software is delivered. If a defect in the media should occur during this period, you may 
return the media to The Amanda Company and The Amanda Company will replace the 
media without charge.

THE AMANDA COMPANY MAKES NO WARRANTIES (OTHER THAN THOSE 
SET FORTH ABOVE) TO ANY PERSON OR ENTITY WITH RESPECT TO THE 
PRODUCT OR ANY DERIVATIVES THEREOF OR ANY SERVICES OR LICENSES 
AND DISCLAIMS ALL IMPLIED WARRANTIES, INCLUDING WITHOUT 
LIMITATION WARRANTIES OF MERCHANTABILITY, PERFORMANCE, 
NONINFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE. THE 
AMANDA COMPANY WILL NOT BE LIABLE FOR ANY BUG, ERROR, 
OMISSION, DEFECT, DEFICIENCY, OR NONCONFORMITY IN ANY SOFTWARE. 
THE SOFTWARE IS LICENSED “AS IS,” AND THE PURCHASER ASSUMES THE 
ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.

IN NO EVENT AND NOTWITHSTANDING ANY DOCUMENT, REPRESENTATION, 
OR OTHERWISE, SHALL THE AMANDA COMPANY BE LIABLE TO YOU FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONTINGENT, OR 
CONSEQUENTIAL DAMAGES, INCLUDING DAMAGES FROM LOSS OR 
CORRUPTION OF DATA, INTERRUPTED USE, LOST PROFITS, COST OF 
PROCURING SUBSTITUTE GOODS, TECHNOLOGY OR SERVICES, EVEN IF THE 
AMANDA COMPANY OR AN AUTHORIZED AMANDA COMPANY DEALER HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOU AGREE THAT 
THE AMANDA COMPANY’S LIABILITY ARISING OUT OF CONTRACT, 
NEGLIGENCE, STRICT LIABILITY, WARRANTY, OR OTHER LEGAL OR 
EQUITABLE THEORY SHALL NOT EXCEED ANY AMOUNTS PAID BY YOU FOR 
THIS PRODUCT. Any written or oral information or advice given by Amanda Company 
dealers, distributors, agents, or employees will in no way increase the scope of this 
warranty, nor may you rely on such oral or written communication. Some states do not 
allow the exclusion or limitation of implied warranties or liability for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. This 
warranty gives you specific legal rights, and you may also have other rights which vary 
from state to state. This Agreement shall be governed by the laws of the State of California 
without regard to the conflicts of laws or provisions thereof.
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Fraudulent Usage Advisory
Although the Amanda software is designed to resist fraudulent usage, including 
unauthorized access to a long distance network, no product, including the Amanda 
software, is able to prevent such unauthorized usage. The Amanda software is likewise 
unable to prevent such uses as may constitute an invasion of privacy or other tort. THE 
AMANDA COMPANY MAKES NO EXPRESS OR IMPLIED WARRANTY AGAINST 
UNLAWFUL OR UNAUTHORIZED USE OF YOUR AMANDA SYSTEM OR ITS 
CAPABILITIES AND HEREBY DISCLAIMS ALL LIABILITY ARISING FROM 
SUCH USE. YOU AGREE TO INDEMNIFY, DEFEND, AND HOLD THE AMANDA 
COMPANY HARMLESS FOR ANY UNAUTHORIZED OR FRAUDULENT USE OF 
YOUR LICENSED AMANDA SOFTWARE.

THE AMANDA COMPANY
4079 Govenor Dr., Suite 320
San Diego, CA. 92122
TELEPHONE (800) 800–9822  FAX (800) 410–2745

Conventions
This manual uses the following terminology and conventions:

Amanda The name by which this manual refers to the Aman-
da@Work.Group/Windows system to make reading 
about the system easier.

caller Someone who calls into Amanda. A caller often ob-
tains information, leaves a message for someone, 
and/or provides information. 

user Someone with an extension that Amanda transfers 
calls to and/or stores messages for. A user can ac-
cess Amanda to play, delete, and send messages as 
well as set personal options such as Do Not Disturb.
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Chapter 1:
Installing Amanda Clients

Introducing the Clients
Amanda’s 16-bit client applications were originally designed for Windows 3.11. However, 
they run fine on Windows 95, Windows 98, and Windows NT, 2000, and XP. Amanda Unif
Messenging is a 32-bit application. There are two versions of Amanda Fax, both a 16-bit 
application and a 32-bit application. The 32-bit applications cannot be installed on 
Windows 3.11.

Amanda Messenger 16-bit application. Allows users to access their messages 
and manage calls from their workstations as well as by 
telephone.

Amanda Unified Messenger 32-bit application. Allows users to access their voice mail 
messages from their Microsoft e-mail application. 

Amanda Dialer 16-bit application. Dials telephone numbers that appear in 
Microsoft Word for Windows, Microsoft Excel, and other 
Windows applications. 

Amanda Fax 32 32-bit application. Allows you to fax anything that you 
can print from a Windows application. It also allows you 
to convert the printable item (document, spread sheet, and 
so forth) into a fax file or a fax message.

Amanda Fax 16-bit application with most of the features of Amanda 
Fax 32. It cannot save a fax as a TIFF file.

Installing Amanda Messenger and Amanda 
Dialer

The Amanda Messenger and Amanda Dialer applications can be installed on each user’s 
workstation. Amanda Messenger and Amanda Dialer can run on Windows 3.11, 95, 98, or 
NT.

To install Amanda Messenger and Amanda Dialer:

1. When Amanda Voice Server was installed, the installation program was placed in a 
shared folder on the server. From the Amanda@Work.Group/Windows server, run 
Clients\ClientInstall.exe.

The Welcome dialog appears.
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2. Click Next>.

The Select Client Folder dialog box appears.

3. Use the default path (C:\AMACLNTS) or type (or browse for) another path in the 
Folder text box.

4. Click Next>.

The Select Type of Installation dialog box appears.

5. Select either the Full Install/Re-Install or the Upgrade option button then click Next>.

The Select Client Applications dialog box appears.
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6. Select the User Clients check box to install Amanda Messenger and Amanda Dialer.

7. Click Next>.

The Select Program Group dialog box appears.

8. Use the default group (Amanda) or type a new group name in the text box.

9. Click Finish.

The Finish the Installation dialog box appears.

10. Click OK.

Installing Amanda Unified Messenger
Amanda Unified Messenger runs on Windows 95, Windows 98, Windows NT,  2000, or XP
computers running a full version of Outlook (such as 97, 2000, 2002, 2003).

Amanda Unified Messenger can communicate with Amanda Voice Server over a TCP/IP 
or NetBIOS/NetBEUI network protocol. However, the installation procedure differs 
slightly for each protocol.

To install Amanda Unified Messenger:

1. When Amanda Voice Server was installed, the installation program was placed in a 
shared folder on the server. From the Amanda@Work.Group/Windows server, run 
Clients\InboxInstall.exe.

The Welcome to Amanda Unified Messaging dialog appears.

2. Click Next...

The Update Default Profile dialog box appears.
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3. If you are installing Amanda Unified Messaging for the first time or adding an addi-
tional Amanda server, click Yes.

If you are reinstalling, click No.

If you are adding an additional mailbox for the same server, you do not need to run 
the installation program—unless you want the additional mailbox to have its own 
address book—in which case, you click Yes here. 

(See “To add an additional mailbox for the same server:” on page 5 for information 
about adding and removing additional mailboxes.)

The Enter Amanda Mailbox Number dialog box appears.

4. Type your mailbox number then click Next>.

The Enter Amanda Mailbox Security Code dialog box appears.
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5. Type your security code then click Next>.

The Remember Security Code dialog box appears.

6. Do one of the following:

• If you want to enter your password every time you log on to your mail applica-
tion, click No.

• If you want Amanda Unified Messaging folders to open automatically without 
password entry, click Yes.

The Enter Amanda Server Name dialog box appears.

7. Type the name of your Amanda server then click Next>.

The default name is AMANDASERVER. Check with your Amanda administrator to 
find out if your Amanda server has a different name.

The Finish the Installation dialog box appears.

8. Click OK.

To add an additional mailbox for the same server:

1. From the Start menu, select Start⇒ Settings⇒ Control Panel, then the Mail icon.

The MS Exchange Settings Properties dialog box appears.

2. On the Services tab, click Add...

The Add Service to Profile dialog box appears.

3. Select Amanda Inbox Folders then click OK.

The Amanda Unified Messenger dialog box appears.

4. On the Logon tab, type the user’s mailbox number and security code in the text boxes.
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5. (Optional) Select the Remember Security Code check box to log in automatically 
without having to type your security code.

6. Select the Network Settings tab.

7. Type the server name in the Server Name text box.

If your network protocol is TCP/IP, the port number is displayed in the Port Number 
box.

If your network protocol is NetBIOS/NetBEUI, type the LANA number (1 or 0) in 
the LANA Number text box.

8. Click OK.

If you did not select the Remember Security Code check box in step 5, the Amanda 
Unified Messenger - Mailbox Logon dialog box appears.

9. If you see the Amanda Unified Messenger - Mailbox Logon dialog box, type the 
security code for this mailbox then click OK.

The MS Exchange Settings Properties dialog box displays an entry for the Folder that 
will contain the messages for the specified mailbox. It consists of the server name, the 
port number, the mailbox number, and the word Folders.

NOTE: You should have an Amanda Address Book per server and a Folder per 
mailbox. You need only one Amanda Transport.

Installing Amanda Fax 32
You can install Amanda Fax 32 on Windows 9x, Me, NT or 2000, but the instructions 
differ as explained in the next two procedures.

In Windows 9x and Me
To install Amanda Fax in Windows 9x and Me:

1. When Amanda server was installed, the installation program was placed in a shared 
folder on the server. From the Amanda server, run Clients\NTFaxInstall.exe.

The introductory dialog box appears.



Chapter 1: Installing Amanda Clients 7
2. Click Next>.

The Name of Printer dialog box appears.

3. Type the name of the printer (or use the default Amanda Fax Service Printer).

4. Click Next>.

The Start Menu Group dialog box defaults to Amanda Fax 32.

5. Use this group or type in a new group.

6. Click Finish.
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The next dialog reports a successful installation.

7. Click OK.

8. If you see the following Warning message, reboot your system:

In Windows NT or 2000
You must be logged in as an administrator.

To install Amanda Fax in Windows NT or 2000:

1. When Amanda server was installed, the installation program was placed in a shared 
folder on the server. From the Amanda server, run Clients\NTFaxInstall.exe.
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The introductory dialog box appears.

2. Click Next>.

The Warning dialog box reminds you that you must be an administrator.

3. Click OK.

The Installation Folder dialog box appears.



10 Using Amanda@Work.Group/Windows Workstation Features
4. Use this folder or browse for another.

5. Click Next>.

The Name of Printer dialog box appears.

6. Type the name of the printer (or use the default Amanda Fax Service Printer).

7. Click Next>.
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The Start Menu Group dialog box defaults to Amanda Fax 32.

8. Use this group or type in a new group.

9. Click Finish.

The next dialog reports a successful installation.

10. Click OK.

11. If you see the following Warning message, reboot your system:
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Installing the 16-bit Amanda Fax
Install Amanda Fax only after you have installed the Amanda Messenger and Amanda 
Dialer software. That installation process automatically installs the SENDFAX.EXE file 
that is required by Amanda Fax.

In Windows 3.11
To install Amanda Fax in Windows 3.11:

1. From Program Manager’s Main group, double-click the Control Panel icon.

The Control Panel group appears.

2. Double-click the Printers icon. 

The Printers dialog box appears. 

3. Click Add>>.

The dialog box expands.

4. In the List of Printers list box, select Install Unlisted or Updated Printer—if it isn’t 
already selected.

5. Click Install….

The Install Driver dialog box appears. 

6. Type the path to or click Browse... to locate the folder on Amanda voice server where 
that stores the OEMSETUP.INF file. Ask your Amanda system administrator for the 
exact path to this folder, if necessary.

Notice that you cannot select a file from this Open dialog box. _OSETUP.INF appears 
to be selected, but that is not the case. Windows 3.11 is concerned only with the 
selected folder (from which it automatically selects OEMSETUP.INF—even though 
that does not appear to be the case). 

7. Click OK to return to the Install From Disk dialog box.

8. Click OK to exit from the Install Driver dialog box.

The Add Unlisted or Updated Printer dialog box appears. Its List of Printers list box 
should display (and have already selected) Amanda Fax.

9. Click OK.

The Printers dialog box reappears. The Installed Printers list box should now include 
Amanda Fax on LPT1 (or a similar listing).

10. Click Close.
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In Windows 95 and Windows 98
To install Amanda Fax in Windows 95 and Windows 98:

1. From the Start menu, select Start⇒ Settings⇒ Printers.

The Printers window appears.

2. Double-click the Add Printers icon.

The Add Printer Wizard dialog box appears.

3. Click Next.

4. Select the Local Printer option button—if it is not already selected.

5. Click Next.

6. Click Have Disk….

The Install From Disk dialog box appears. 

7. Type the path to or click Browse... to locate the folder on Amanda voice server where 
that stores the OEMSETUP.INF file. Ask your Amanda system administrator for the 
exact path to this folder, if necessary.

Notice that you cannot select a file from this Open dialog box. _OSETUP.INF appears 
to be selected, but that is not the case. Windows NT is concerned only with the 
selected folder (from which it automatically selects OEMSETUP.INF—even though 
that does not appear to be the case). 

8. Click OK to exit the Install From Disk dialog box.

The Add Printer Wizard dialog box reappears. Amanda Fax appears in the Printers list 
box.

9. Click Next.

10. Select the FAX port (or any port other than FILE) from the Available Ports list box.

NOTE: The port selection is unimportant because Amanda Fax does not use 
a port on this machine. Your selection only affects the icon in the 
Printers group. Your selection does NOT affect any other applica-
tion or printer configuration.

11. Click Next.

12. You probably do NOT want Amanda Fax as your default printer and should select the 
No option button. If you plan to use Amanda Fax as the default printer, select the Yes 
option button instead.

13. Click Next.

14. Click Yes to send a test fax page.

15. Click Finish.

The Amanda Fax dialog box appears.
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16. Do one of the following:

• To send the test page to your fax machine, select Fax Out then click OK.

You are asked for your mailbox and security code, then a fax number.

• To send the test page as a message, select Send to Messenger… then click OK.

You are asked for your Amanda Messenger mailbox.

Within Amanda Messenger, click the Compose window to make it active, dou-
ble-click the fax component to view the page.

17. If the test page is OK, click Yes in answer to the question about that in the Amanda 
Fax dialog box.
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Logging On to Amanda
Amanda Messenger provides a workstation interface for managing messages. It is easier 
to use and has more options than are available when using a touch-tone telephone. 

When you start Amanda Messenger, you must log on to the Amanda voice server.

To use Amanda Messenger:

1. Double-click the Amanda Messenger icon. In Windows 95, 98, or NT, you can select 
Amanda Messenger from the Start menu.

The Messenger Logon dialog box appears.

2. Click Network Settings…. 

The Network Settings dialog box appears. 

3. Type the server name in the Server Name text box. 

See your Amanda system administrator for the correct name.

4. Click OK.

The Messenger Logon dialog box reappears.

5. Type your mailbox in the Mailbox text box.

Your mailbox is probably the same as your extension number, but it doesn’t have to 
be. Check with your Amanda system administrator to be sure.

6. Type your security code in the Security Code text box.

(This is the same security code that you use to access Amanda over the telephone.)

7. Click OK.

Amanda Messenger appears. Its main window contains:
New Messages window Lists all unheard messages and any that 

were not saved or deleted after having 
been heard.

Saved Messages window Lists all previously heard messages.
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Logging Back On
If you lose connection to Amanda voice server while you are using Amanda Messenger, 
you can log back on without exiting Amanda Messenger.

To log back on to Amanda:
• On the System menu, click Log On.

A message indicates that you are logged on or that the server is unavailable.

More Than One Logon
Using Amanda Messenger, more than one user can log on to the same mailbox at the same 
time—as long as they all know its security code. For example, if customers who call when 
all the lines are busy can choose to leave a message, customer service representatives 
might all monitor the mailbox that stores those messages. On busy days, some employees 
may be answering calls, while others process the oldest messages that have been left. 

To prevent others from processing the same messages, employees must remove messages 
from the New Messages window as they start to process them. The supervisor can use 
Amanda Messenger to monitor that mailbox, determining how to schedule employees’ 
time, when to answer messages along with the others, and so forth.

Changing Your Security Code
As you start Amanda Messenger, you are prompted for your security code. Amanda 
Messenger uses that code to log you on to Amanda voice server. Once logged on, you can 
listen to your messages, send messages, and so forth.

It is a good idea to change your security code occasionally. You can change it at any time. 
Use up to eight digits. Security codes are always numeric so they can be entered using a 
touch-tone telephone.

To change your security code:

1. On the Options menu, click Security Code….

The Change Security Code dialog box appears. For security reasons, the dialog box 
does not display security codes.

2. Type your current code in the Current Security Code text box.

Asterisks appear as you type.

3. Type the new code in the New Security Code text box.

4. Confirm the new security code by retyping it into the Verify New Security Code text 
box.

Trash Bin window Lists all deleted messages.

Message Statistics Displays read-only information about 
your mailbox.
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Message Windows
The message windows (New Messages, Saved Messages, and Trash Bin) list messages for 
each mailbox.

Amanda Messenger puts every incoming message in the New Messages window. In 
general, you should use this window only for messages that you haven’t played or, in the 
case of fax messages, haven’t viewed. However, unless new messages are automatically 
saved, the New Messages window lists any messages that you have not saved or deleted, 
regardless of whether you have played or viewed them. While there are messages in this 
window, your message light (if you have one) remains on, so it is important that you move 
messages to the Saved Messages or the Trash Bin window. On the Messages menu, you 
can click Update Messages to save the messages that have been listened to or viewed all at 
once.

The Saved Messages window is for messages you want to keep for a while. For example, 
they may contain information you need to get your job done. Depending on the 
workstation options you set, Amanda Messenger may automatically save every new 
message as you play or view it.

The Trash Bin window lists messages that you no longer want. You put them there, but, 
while the messages are still in the Trash Bin window, you can change your mind and move 
them to the Saved Messages window. Unwanted messages are permanently deleted as you 
exit Amanda Messenger.

By default, the oldest message is at the top of each list and the newest message is at the 
bottom (sorted by date and time).
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Understanding Information Columns
Each message window contains five columns:

Date Displays the date associated with the message. Depending on Amanda 
voice server options, it is either the date the message was recorded or 
the date the message was forwarded. This column sorts in ascending 
(oldest to newest) order.

From Displays one of the following:
The mailbox and/or name of the Amanda user who is contacting you. 
What information you see here depends on the workstation options 
you have set.
The word “Outside” if the call originated outside the Amanda system.
This column sorts in alphanumeric order.

Attributes Displays additional message markings: Urgent, Private, Receipt
Urgent: Indicates that the caller who recorded the message marked it 
urgent. 
Private: Indicates that the caller who recorded the message marked it 
private (so it cannot be forwarded).
Receipt: Indicates that the message you sent to a coworker (along with 
a request for verification) was heard or viewed. 
This column sorts from highest to lowest: Urgent, Private, Receipt, 
none

Length Displays one of the following: 
For a one component voice message, displays the total length in sec-
onds.
For a one component fax message, displays the total number of pages.
For a multi-component message, displays the total number of compo-
nents. A multi-component message can contain both fax and voice 
messages.
This column sorts in ascending numerical length.

Subject Displays the subject (up to 50 characters) of the message. For an out-
side call, this can be the caller ID information captured using the “ccc” 
integration pattern or captured using the caller_id configuration pa-
rameter. For details, see Installing Amanda@Work.Group/Windows.)
To add or edit a subject, do one of the following:
• On the Messages menu, click Edit Subject…. 
• Double-click the Subject column for the message.
• This column sorts in alphanumeric order.
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Resizing and Reordering Columns
You can adjust the width of columns and reorder them for convenience. For example, you 
might want the Subject column to be wider and be the third column.

To adjust a column’s width:
• Position the mouse pointer over the separator to the right of the column and drag 

the separator horizontally to change the column’s width.

This changes the size of the column preceding the separator and the last column.

To hide a column:
• Position the mouse pointer over the separator to the right of the column and drag 

the separator to the left as far as possible.

To hide the last column, widen the second-to-last column.

To reorder the columns:
• Position the mouse pointer over the column header and drag it to the column’s new 

position. 

Sorting Rows
By default the rows are sorted by date, but you can sort them based on the data in any 
column. For example, you might want to sort them by who they are from so you can 
review all the messages from a particular person more easily.

To sort the rows:
• Click a header to sort the messages based on the contents of that column. 

This column becomes the primary sort column. The previous primary sort column 
becomes the secondary sort column, and so on.

The number to the right of the header indicates the column’s order in the sort: 1 indicates 
the primary sort column, 2 indicates the secondary sort column, and so on.

To create a secondary sort:

1. Click the column header for the column on which the secondary sort is to be based. 

2. Click the column header for the column on which the primary sort is to be based. 

Setting Up Amanda Messenger
To make sure that Amanda Messenger operates the way you want it to, you need to set 
workstation options.

To set up Amanda Messenger:

1. On the Options menu, click Workstation Options….

The Workstation Options dialog box appears.

2. Set any of the workstation options explained in the following sections.
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Setting Play/Record Options
To play messages and to record greetings and messages, Amanda Messenger needs 
information about your telephone extension and how you plan to use your workstation’s 
sound card.

To set up Amanda Messenger for playing and recording:

1. From the Workstation Options dialog box, type your extension or the digits Amanda 
Messenger should dial to reach you in the Extension text box.

If your Amanda system is connected to more than one telephone switching system, 
you can use only one of those switching systems for telephone support (for example, 
if and when you have the system play a message to you over the telephone). By 
default PBX 1 is used; to use PBX 2, include “2:” in front of you extension number. 
For example, if your extension number is 147, use 2:147 in the Extension text box.

2. Select the Wait for Answer check box to make Amanda wait for a voice response 
before playing or recording. Clear it to avoid a wait if, for example, your telephone 
switching system does not allow Amanda to wait for an answer.

3. Select the Use Speakers option to play messages from your workstation. 

When cleared, the play functionality on your workstation is disabled and Amanda 
Messenger calls you on the telephone to play your messages.

4. Select the Use Microphone option if you want to record using your workstation. For 
example, sound can reach the sound card via your workstation’s microphone or CD 
ROM drive. 

When cleared, Amanda Messenger calls you on the telephone to record greetings and 
messages.

Converting from Stereo to Mono
When importing a stereo .WAV file, it must be converted to mono. You select the stereo 
channel on which to base its conversion.

To select a stereo import conversion channel:
• From the Workstation Options dialog box, click one of the following option but-

tons:

• Left Channel 

• Right Channel

• Average of Both

Being Notified about New Messages
If Amanda Messenger is running (even in the minimized mode), it can notify you every 
time a new message is received by displaying a message on your workstation.

To be notified about new messages by Amanda Messenger:
• From the Workstation Options dialog box, select the Notify about New Message 

check box. Clear the check box to avoid this type of notification.
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Displaying Mailbox Names
You can control how mailboxes and their names (the contents of both Directory Name 1 
and Directory Name 2) are displayed in Amanda Messenger. 

Select one of the following option buttons: 
Mailbox Followed by Name Displays both the name and the mailbox, with the mailbox 

first. 
Name Followed by Mailbox Displays both the name and mailbox, with the name first. 
Mailbox Only Displays only the mailbox. 
Name Only Displays only the name. 

Your selection determines the order a mailbox and name is displayed in the From column 
in the New and Saved Messages windows and in user lists. Regardless of your selection, if 
there is no name, Amanda Messenger displays only the mailbox. 

Saving New Messages Automatically
Normally new messages stay in the New Messages window until you move them to either 
the Saved Messages or the Trash Bin window using drag-and-drop or either the Save or 
Update Messages commands on the Messages menu.

However, Amanda Messenger can move messages to the Saved Messages window for you 
automatically as soon as they are heard or viewed.

To save messages automatically:
• From the Workstation Options dialog box, select the Autosave New Message 

check box. Clear the check box to save messages manually. 

NOTE: If you listen to a message using the telephone, the message is automati-
cally moved to the Saved Messages window with or without this option.

Prompt to Empty Trash Bin on Exit
Amanda Messenger automatically deletes all the messages in the Trash Bin window as 
you exit. When you exit, Amanda Messenger can remind that the messages in the trash bin 
will be deleted and allow you to cancel the exit. 

To exit Amanda Messenger with or without the reminder:
• From the Workstation Options dialog box, select the Prompt to Empty Trash Bin 

on Exit check box to be notified that messages will be deleted if you exit. Clear 
the check box to exit (and delete the messages) without the reminder.
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Managing Messages
This section explains how to handle both voice messages and fax messages.

Playing or Viewing a Message
As you receive voice or fax messages, your message light goes on and your workstation 
prompts you (unless you have stopped new message notification). You, of course, will 
want to review them.

To play a voice message or view a fax message:
• Double-click the message.

You can also select the message and click Play on the Play menu, View Fax on the Fax 
menu, or Play from the player controls.

NOTE: Double-clicking the subject column for a message displays the Edit Sub-
ject dialog box.

Saving a Message
Depending on the workstation options you set, Amanda Messenger may automatically 
save every new message after you play it. Otherwise, to save a message, you must move it 
from the New Messages window or the Trash Bin window to the Saved Messages window.

To save messages manually, do one of the following:
• Drag the messages to the Saved Messages window.
• Select the messages. Then, on the Messages menu, click Save.
• On the Messages menu, click Update Messages to move all the messages that have 

been listened to or viewed to the Saved Messages window. In this case, you do not 
need to select them.

• Move the messages by copying them from the original window and pasting them 
in the Saved Messages window. Copy and Paste are on the Edit menu and the tool-
bar:

Copy  and Paste .

NOTE: Copying messages results in a move if the destination is a message 
window. It results in a copy if the destination is a Compose window.

To save new messages automatically, see “Saving New Messages Automatically” on 
page 21.

Deleting a Message
You move selected messages from the New Messages or Saved Messages window to the 
Trash Bin window when you no longer want those messages.

To put messages in the trash bin, do one of the following:
• Drag the messages to the Trash Bin window.
• Select the messages. Then, on the Messages menu, click Delete.
• Select the messages. Then, press the Delete key.
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• Move the messages by copying them from the original window and pasting them 
in the Trash Bin window. Copy and Paste are on the Edit menu and the toolbar:

Copy  and Paste .

While the messages are still in the Trash Bin window, you can rescue them.

NOTE: Copying messages results in a move if the destination is a message 
window. It results in a copy if the destination is a Compose window.

To rescue messages from the trash bin, see “Saving a Message” on page 22.

To permanently delete messages, you empty the Trash Bin window or exit Amanda 
Messenger.

To empty the trash bin, do one of the following:
• From the Messages menu, click Empty Trash Bin.
• Allow the trash to be emptied automatically as you exit Amanda Messenger.

Composing a Message
You can record a new message or a component for a new message using your telephone or 
your workstation. Your workstation options indicate what device you use to record. You 
can also add a component from an existing message or import an existing .WAV file as a 
component.

To use your telephone or your workstation:

1. On the Options menu, click Workstation Options….

The Workstation Options dialog box appears.

2. Do one of the following:

• Select the Use Microphone check box to record messages using your worksta-
tion. For example, you can record messages by speaking or playing music into a 
microphone, from a CD, and/or via your in-line jack.

• Clear the Use Microphone check box to record messages using your telephone.

To record a message using the telephone:

1. On the Messages menu, click New Message.

An empty Compose window appears.

2. On the Play menu, click Record.

Your extension rings.

3. Answer the telephone and Amanda will prompt you through the recording process.

After you save the recording, its component number appears in the active window. 

TIP: You can start with step 2. When you save the recording, a Compose win-
dow is created automatically if no Compose window is active.
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To record a message using the workstation’s sound card:

1. On the Messages menu, click New Message.

An empty Compose window appears.

2. On the Play menu, click Record.

3. Immediately start speaking into the microphone or playing a CD (or other device) for 
.WAV files.

4. On the Play menu, click Stop.

The Approve or Reject dialog box appears.

5. Click Review to listen to your recording.

6. Click Save to save it or Cancel to reject it. If you reject the recording, redo steps 2 
through 6.

The number for the recorded component appears in the Compose window. 

TIP: You can start with step 2. When you save the recording, a Compose win-
dow is created automatically if no Compose window is active.

To create a message using components from other messages:

1. On the Messages menu, click New Message.

An empty Compose window appears.

2. From a message window, right-click a message that contains a component to be used 
in the new message.

A Message Components window lists (by number) the components in the selected 
message.

You can double-click a component to play it.

3. Drag one or more of the components from the Message Components window to the 
Compose window. (Or use the Copy and Paste commands on the Edit menu.)

4. Repeat steps 2 and 3 for any other messages that have components to be used in the 
new message.

TIP: To use the entire message as part of the new message, you can drag it di-
rectly from the message window to the Compose window.

Using Message Components
Every message contains from 1 to 20 components. For example, if a message is forwarded 
from one mailbox to another, it may have two components: the original message and the 
prefix recorded by the person who forwarded the message. If that same message is 
forwarded to another mailbox with another prefix, it will contain three components.
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To list a message’s components, do one of the following:
• Right-click on the message 
• Select the message. Then, on the Messages menu, click Show Components.

A Message Components window lists (by number) the components in the selected 
message. You can do any of the following:
• Double-click a component to play it.
• Copy components to a Compose window by dragging them to the new win-

dow or by using Copy and Paste. 

Copy and Paste are on the Edit menu and the toolbar:

Copy  and Paste .

Sending a Message
Your message includes all the components in the active Compose window. You can send it 
to only one of the following:
• Individual users
• Personal mailing lists
• System mailing lists

For example, to send a message to two individuals, two personal mailing lists, and one 
system mailing list, you need to send the message three times.

To send a message that has been composed:

1. Select the Compose window that contains the message to be sent.

2. On the Messages menu, click Send….

The Message Send Information dialog box appears.

3. Indicate whether you are sending the message to a mailbox or a list of mailboxes by 
selecting the Mailboxes, Personal List, or System List option button.
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When you make your choice, the list box to the right of the option buttons changes to 
display mailboxes, personal mailing lists, or system mailing lists.

4. Do one of the following:

• If you selected the Mailboxes option button, select one or more mailboxes. 

You can type the first mailbox number in the text box above the list. If the name 
is displayed before the mailbox, type the first few letters of the user’s name. (This 
is faster than scrolling to find a recipient for your message.)

• If you selected the Personal List or System List option buttons, select one or 
more of the lists displayed in the list box.

TIP: Double-click a mailbox or list to immediately send the message to 
that mailbox or list. To send to more than one mailbox or more than 
one list, use multiple selection (using Shift+click or Ctrl+click) then 
click OK.

5. Select any combination of the following check boxes:

• Select Urgent to mark the message as urgent.

• Select Private to make your message unforwardable.

• Select Return Receipt Request to receive a message from Amanda when each 
recipient plays the message. It is also shown as an attribute of the message in 
Amanda Messenger.

6. Type a subject for the message (up to 50 characters) in the Subject text box.

7. Click When to Send if you want to send the message at a future date and time.

The Future Delivery Date and Time dialog box appears.

8. Type or use the spin boxes to select the delivery date and time.

If you select a date or time in the past, Amanda delivers the message immediately.

9. Click OK to return to the Message Send Information dialog box.

Forwarding a Message
You can forward more than one message as one message. You can forward it exactly as it 
is with no prefix, or you can forward it with a prefix and other additional components.

To forward a message exactly as it is:

1. Select the message or messages to be forwarded from a message window.

2. Do one of the following:

• Click Forward Immediately on the toolbar.

• On the Messages menu, click Forward Immediately….

The Message Send Information dialog box appears.

3. Indicate whether you are sending the message to a mailbox or a list of mailboxes by 
selecting the Mailboxes, Personal List, or System List option button. 
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When you make your choice, the list box to the right of the option buttons changes to 
display mailboxes, personal mailing lists, or system mailing lists. 

Do one of the following:

• If you selected the Mailboxes option button:
a. Select one or more mailboxes.
b. Type the first mailbox number in the text box above the list. If the name 

is displayed before the mailbox, type the first few letters of the user’s 
name. (This is faster than scrolling to find the first recipient for your mes-
sage.)

• If you selected the Personal List or System List option buttons, select one or 
more of the lists from the list box. 

TIP: Double-click a mailbox or list to immediately send the message to 
that mailbox or list. To send to more than one mailbox or more than 
one list, use multiple selection (using Shift+click or Ctrl+click) then 
click OK.

4. Select any combination of the following check boxes:

• Select Urgent to mark the message as urgent.

• Select Private to make your message unforwardable.

• Select Return Receipt Request to receive a message from Amanda when each 
recipient plays the message. It is also shown as an attribute of the message in 
Amanda Messenger.

5. Type a subject for the message (up to 50 characters) in the Subject text box.

6. Click When to Send if you want to send the message at a future date and time.

The Future Delivery Date and Time dialog box appears.

7. Type or use the spin boxes to select the delivery date and time.

If you select a date or time in the past, Amanda delivers the message immediately.

8. Click OK to return to the Message Send Information dialog box.

To forward a message with a prefix or other additional components:

1. Select the message or messages to be forwarded from a message window.

2. On the Messages menu, click Forward….

The Prefix Message dialog box appears.

3. Click Record.

If you are using a sound card and microphone, speak into the microphone and click 
Stop when you have finished. The Approve or Reject dialog box appears. Use it to 
review, save, or cancel your prefix.

If recording through the telephone, Amanda rings your extension and says, “Begin 
recording at the tone. Finish by pressing # or hanging up.” If you finish by pressing #, 
Amanda allows you to review the recording, append it to the previous recording, or 
reject it.

A Compose window displays the components of the message to be forwarded pre-
ceded by the component you just recorded. Each component has a ten-digit number 
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that identifies it. An icon and the word Voice appears to the left of the number. (This 
window is not active.)

4. After saving your prefix, the Message Send Information dialog box appears.

5. Follow steps 3 through 8 in the above procedure “To forward a message exactly as it 
is.”

To record an additional component:

1. On the Play menu or from the player controls, click Record.

After you approve the recording, a component appears in the Compose window.

2. You can repeat step 1 to create additional recorded components. For example, you 
might create a prefix and a postfix for a component copied from another message.

To copy a component from another message:

1. Right-click the message.

2. A Message Components window appears.

3. Copy one or more components from the window.

4. Paste the components into the Compose window.

5. You can repeat steps 1 through 3 to copy components from other messages.

To import a .WAV file as a message component:

1. On the Messages menu, click Import Message....

The File Open dialog box appears. 

2. Use this dialog box to locate the .WAV file then click OK. 

3. You can repeat steps 1 and 2 for additional .WAV files.

To import an image file as a message component:

You can import .TIF, .DCX (multiple-page .PCX), and other image files into Amanda 
Messenger and then send them as fax messages to coworkers. If you created a file from 
another application, such as Microsoft Word, using the Amanda Fax Driver, that file has 
the .FAX extension and can also be imported.

1. Do one of the following:

• Click Open Fax  on the toolbar.

• On the Fax menu, click Open....

The File Open dialog box appears.

2. Use the dialog box to select the file to be viewed then click OK.

The image appears in a window. 
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3. On the Fax menu, click Import Fax.

The image file is converted to a fax component. The component number appears in a 
new Compose window.

4. Drag the new component to the Compose window where you are creating your mes-
sage.

Replying to a Message
When you reply to a message sent to you by someone on the Amanda system, Amanda 
Messenger automatically addresses your reply to that person. 

To reply to a message:

1. Select the message to be replied to.

2. On the Messages menu, click Reply.

An empty Compose window appears.

3. On the Play menu or player controls, click Record and record your response.

See “Composing a Message,” earlier in this chapter, for more information.

4. On the Messages menu, click Send….

Amanda Messenger addresses the message for you.

See “Sending a Message,” earlier in this chapter, for more information.

Managing Fax Messages
You can view fax messages, rotate their pages, print them, and save them as image files 
using .TIF (Group 3) or .DCX format. You can also open .TIF or .DCX files for viewing in 
Amanda Messenger. Once it is open, you can import it as a fax message.

If a fax message was sent to you from an internal source, you can forward it and reply to it. 
See the “Forwarding a Message” and “Replying to a Message” sections, earlier in this 
chapter.

To view a fax message, do one of the following:
• Double-click the selected fax in a message window.
• Select the message. Then, on the Fax menu, click View Fax.
• Select the message. Then, on the Play menu, click Play.
• Select the message. Then, on the Player control toolbar,

 click Play .

Amanda Messenger displays the selected fax message in a new Fax window. Each page is 
represented as a small thumb-nail-sized rectangle called a “thumbnail.” Click the first 
thumbnail to view the first page. Click it a second time to return to the thumbnail.

After displaying a fax, click Rewind or Fast Forward on the player controls toolbar to 
move to the previous and next pages. 

To rotate the pages in a fax message:
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1. On the Fax menu, click Rotate Fax….

The Rotate Fax dialog box appears.

2. Select an option button to rotate all the pages in the message:

• 90 degrees (clockwise or counter-clockwise)

• 180 degrees (upside-down)

• Around the x-axis (mirror image)

• Around the y-axis (upside-down mirror image)

To print all or part of a fax message:

1. On the Fax menu, click Print….

The Print dialog box appears.

2. Do one of the following:

• Select the All option button to print the entire fax message.

• Select the Pages option button and supply a range of pages.

3. Set any other options that are appropriate (such as number of copies).

4. Click Setup to change printer options if necessary.

(You can also change printer options by selecting Print Setup… from the Fax menu.)

NOTE: You can preview the message before printing it. (On the Fax menu, click 
Print Preview.) From the preview window, you can print the fax after 
viewing its pages one at a time or in pairs. You can magnify pages for 
better viewing, but you cannot rotate them.

To save a fax message as a .TIF or .DCX file:

1. On the Fax menu, click Save As….

The File Save As dialog box appears.

2. Provide a name and location for the new file.

If the extension is not .TIF or .DCX, the Verify Save Type dialog box asks you what 
format the file has.

To view a .TIF or .DCX file in Amanda Messenger:

1. On the Fax menu, click Open….

The File Open dialog box appears.

2. Provide the name and location for the file then click OK.

A window displays the pages of the file. The file’s name appears in the title bar.
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To import an image file as a fax message:

1. On the Fax menu, click Open….

The File Open dialog box appears.

2. Provide the name and location for the file then click OK.

A window displays the pages of the file. The file’s name appears in the title bar.

3. On the Fax menu, click Import Fax.

Amanda Messenger converts the image file to a message and displays its component 
number in a Component window. 

Now you can send it.

Managing Mailing Lists
You can create up to 29 personal mailing lists (numbered from 1 to 8 and from 10 to 30). 
When you add a mailbox to a mailing list, the Amanda system confirms that:
• The new mailbox shares at least one group with you
• The new mailbox (or its copy-to mailbox) can receive mail

Otherwise the mailbox cannot be added to your mailing list. For more information about 
groups, see Administering Amanda@Work.Group/Windows.

To create or edit a list:

1. On the Options menu, click Personal Lists….

The Personal Lists dialog box displays three list boxes:

• The 29 possible lists in the Lists box

• The mailboxes for all possible users in the All Possible list box 

• The mailboxes currently on the list in the Current List box

2. Type or select the number of the list to be created or edited.

3. Double-click mailboxes in the All Possible list box to add them to the Current List 
box (if they are not already on the list).

4. Double-click mailboxes in the Current List box to remove them from the list.

TIPS: To add more than one mailbox to the list at one time, select the mail-
boxes to be added from the All Possible list box, then click 
>>Add>>.
To remove more than one mailbox from the list at one time, select 
the mailboxes to be removed from the Current list box, then click 
<<Remove<<.
After selecting the list box that contains the list number or mailbox, 
type the first character in the list or mailbox. Amanda Messenger im-
mediately goes to the first entry that begins with the character you 
typed. Type that character again to go to the next match.

5. (Optional) To give the list a name to remind you of its contents, click Edit List 
Name….

The Edit Personal List Name dialog box appears.



32 Using Amanda@Work.Group/Windows Workstation Features
6. Type a name for the list in the List Name text box. 

You can use up to 71 characters, but the Lists box displays about 15.

To empty a list:

1. On the Options menu, click Personal Lists….

2. Select the number of the list to be emptied.

3. Click Empty List.

Viewing Message Statistics
The Message Statistics window display statistics about your messages.

Controlling Call Processing
Your Amanda system administrator sets most of the options that control how your calls are 
processed. You can:
• View these options from your workstation
• Reset those that your administrator allows you to

You can reset these options using your telephone as well as Amanda Messenger. For 
more information, see Using Amanda@Work.Group/Windows Telephone Features.

• Request changes to be made by the administrator

Changing Basic Options
You can view and often change your mailbox’s basic options. For example, you can:
• Always control options such as whether Amanda plays the date and time
• Control options such as Do Not Disturb only when your Amanda system admin-

istrator has not locked those features
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The options that you can control can be changed using Amanda Messenger or using the 
telephone. For more information, see Using Amanda@Work.Group/Windows Telephone 
Features.

To view basic options:
• On the Options menu, click Basic Options…

The Basic Options dialog box displays the options that are described in the following 
table.

Basic Options
Option Description

Do Not Disturb When this check box is selected, Amanda plays the Ring No Answer (RNA) 
greeting without trying to call you. When cleared, Amanda performs the pro-
grammed dial actions in the Extension text box. Usually, this calls your exten-
sion.

Call Screening  You can screen calls if the following conditions exist:
• This option is selected
• Do Not Disturb is cleared
• The Amanda system administrator has configured Amanda to per-

form supervised transfers
Amanda asks the caller, “At the tone, please say your name and company.” The 
caller’s response is played for you when you answer the telephone. You accept 
or reject the call based on who is calling. Press * to have the system repeat the 
name and company recording made by the caller.

If a mailbox has both Call Screening and Identify Called Party selected, you 
hear one of the following (depending on options set by your Amanda system ad-
ministrator):
• Only the mailbox that the call is for. Callers are not asked for their name 

and company. In this way, you can accept or reject the call based on the 
called party. (This is designed for extensions that receive calls for more 
than one user, department, and so forth.) 

• Both the mailbox and the caller’s name and company. This allows you to 
accept or reject the call after hearing information about both the caller and 
the called party.

Identify Called Party When this check box is selected and Amanda performs a supervised transfer, 
Amanda plays the Name and Extension recording of the mailbox that was 
called. This is useful when two or more mailboxes ring the same telephone ex-
tension. (Messages are stored with the mailboxes, so each user’s messages are 
private.)
When Identify Called Party is cleared, Amanda plays a connection tone that 
only the called party can hear before connecting the caller. 

NOTE:  If the Extension text box in the General Mailbox Information dialog box 
indicates an unsupervised transfer (for example, 127H), Identify Called Party is 
not available.

Play Date & Time When this check box is selected and a message is played, Amanda plays the date 
and time when that message was recorded followed by the message itself. When 
cleared, the date and time are not played. 

NOTE:  If you are listening to the message over the telephone, you can press 74 
at any time during the message to hear its date—even if this option is cleared.
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Managing Waiting Calls
 If a call arrives while you are using your extension and you use the Manage Waiting Calls 
feature, the Waiting Calls dialog box appears on your workstation. 

Use it to:
• Connect to the waiting caller (after you terminate the current call)
• Transfer the caller to a coworker
• Place the caller on hold
• Have Amanda take the caller’s message

Preparing for Waiting Calls
For minimal preparation for managing waiting calls, perform steps 1 through 3 of the 
following procedure. While this is the simplest way to set up for waiting calls, remember:
• You have only a few seconds to respond to a waiting call after Amanda notifies 

you about it. After the time expires, Amanda treats your waiting call as though 
Manage Call Waiting was not being used and puts the caller on hold.

NOTE: The amount of time depends on the setting for the 
tmo_call_screening configuration option set by your Amanda sys-
tem administrator—although you can reduce the number of seconds.

• Your caller waits while you notice that you have a waiting call and while you de-
cide what to do with it.

It is best to make complete preparations for waiting calls.

To set up Amanda Messenger so that you can manage waiting calls:

1. On the Options menu, click Workstation Options….

The Workstation Options dialog box appears.

2. Select Use Speakers so you can play the name and company after your caller records 
it (if you have a sound card).

3. Select Manage Waiting Calls so the Waiting Calls dialog box appears on your work-
station when your extension is busy and another call arrives.

4. Click Notification… to control how Amanda Messenger notifies you about calls that 
arrive while your extension is busy.

The Notification Options dialog box appears.
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5. By default, the Waiting Call dialog is made active, even if Amanda Messenger is min-
imized. It is best to keep Make Window Active and Restore if Minimized selected. 

• To hear a beep, select beep then click OK.

6. Click Configuration… to streamline the way waiting calls are processed. Save your-
self (and your caller) time by deciding in advance about:

• Which greeting to play when you want to:

•Put the caller on hold

•Have the caller leave a message

•Transfer the caller to a coworker

• Which coworker to transfer calls to or which coworkers to put on your personal 
transfer list

Use the following procedures to set the remaining options you need.

To specify greetings for waiting calls:

1. Click Configuration….

The Waiting Call Configuration dialog box appears.

2. Click the Edit... button beside the type of response: Hold Greeting, Take Message 
Greeting, or Transfer Greeting.

The Hold Greeting, Take Message Greeting, or Transfer Greeting dialog box appears.

3. Select one of the entries in the Greeting List box.

Selecting Prompt (the default) allows you to postpone a decision about what greeting 
to play until after the call arrives. 

(Use this if you have more than one greeting for a hold, for message taking, or for 
transferring. For example, if you transfer one type of call to one coworker and another 
type of call to another coworker, you might have a separate greeting for each type of 
call.)

In the Hold Greeting dialog box, you can select the custom busy greeting in addition 
to one of the seven greetings.
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Amanda Messenger will automatically play this greeting whenever you respond to a 
waiting call with this type of response.

4. Repeat steps 2 and 3 for other types of call responses.

To specify a single coworker:

1. Click Configuration….

The Waiting Call Configuration dialog box appears.

2. Click the Edit... button beside Transfer to Mailbox.

The Transfer Mailbox dialog box appears.

3. Select the mailbox (or select prompt to postpone the selection of a mailbox until after 
the call arrives).

Amanda Messenger will transfer all the waiting calls that you decide to transfer to this 
mailbox.

To create a personal list of mailboxes to which you transfer calls:

1. Click Configuration….

The Waiting Call Configuration dialog box appears.

2. Select one or more mailboxes from the Mailbox List box.

3. Click >>Add>> to add them to the Personal List box.

Amanda Messenger will display this list when you decide to transfer a waiting call.

TIP: Double-click a mailbox to immediately add it to the Personal List 
box. 
To remove a mailbox from the Personal List box, double-click it.
To remove more than one at a time, select them then click <<Re-
move<<.

To reduce the amount of time you have to manage the call:

1. Click Configuration….

The Waiting Call Configuration dialog box appears.

2. Clear the Default check box.

The Time Out text box becomes enabled.

3. Type a number of seconds in the text box.

Managing a Call after Minimal Preparation
The following procedures explain how to use Manage Waiting Calls without doing any 
preplanning. A little preparation on your part can save you steps and, more importantly, 
time. You have only a few seconds to manage the call before Amanda places it on hold—
just as without Manage Waiting Calls.
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To listen to the name and company name of your caller:

1. From the Waiting Calls dialog box, click Play Name.

Note: Play Name is not available if Use Speakers is not a selected work-
station option.

2. Do one of the following procedures.

To place this waiting call on hold:

1. From the Waiting Calls dialog box, click Hold.

The Hold Greeting dialog box appears.

2. Select the greeting that Amanda will play to your caller from the Greeting list box.

3. Click Hold.

After the hold, the Waiting Calls dialog box reappears so you can process this call 
again.

TIP: Configure Manage Waiting Calls to use either your custom busy greeting 
or a specially recorded hold greeting (one of your greetings) automatical-
ly.

To connect yourself to the caller:
• From the Waiting Calls dialog box, end your current call then click Connect.

To have the caller leave a message:

1. From the Waiting Calls dialog box, click Take Message.
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The Take Message Greeting dialog box appears.

2. Select the greeting that Amanda will play to your caller from the Greeting list box.

3. Click Take Message.

TIP: Configure Manage Waiting Calls to use either your usual RNA (Ring No 
Answer) greeting or a specially recorded take-message greeting (one of 
your greetings) automatically. 

To transfer this call to a coworker:

1. From the Waiting Calls dialog box, click Transfer.

The Transfer Greeting dialog box appears.

2. Select the greeting that Amanda will play to your caller from the Greeting list box.

3. Click Transfer.

The Transfer Waiting Call dialog box displays all the mailboxes on the Amanda sys-
tem.

TIP: Configure a mailbox for all transfers or make a transfer list so you 
can select from a smaller list instead of all the mailboxes in the 
Amanda system. (If you have a personal transfer list, you can still 
view all the mailboxes on the system by checking the Show All 
Mailboxes check box.)

4. Select a mailbox then click OK.
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The Transfer Greeting dialog box displays your greetings.

5. Select a greeting then click OK.

TIP: Record a special transfer greeting (one of your greetings) and con-
figure Manage Waiting Calls to use it automatically. 

Managing Greetings
Amanda provides a system Ring No Answer (RNA) greeting and a system busy greeting 
for when you do not answer or your extension is busy. Amanda also provides a default 
Name and Extension recording that identifies you by your mailbox. 

Unless these options have been locked by your Amanda system administrator, you can use 
Amanda Messenger to record or import .WAV files for:
• Up to seven greetings. (You can switch from one greeting to another as appropri-

ate.) For example, you can have one greeting for regular work days, another for 
after hours, another for when you are out of the office, and so forth.

• A custom busy greeting.
• A personalized Name and Extension recording.

Controlling the Greeting
You can use the system greeting or one of your own greetings. You can change them to 
suit your needs. For example, to use different greetings for when you are at your desk and 
when you are not, change your greeting as you leave and return. (Routine changes, such as 
for daytime and after-hours, can be scheduled. See your Amanda system administrator for 
details.)

Amanda plays the selected greeting when any of the following is true:
• Do Not Disturb is selected.
• Do Not Disturb is cleared, you do not answer the telephone, and the RNA Chain 

is blank.
• Call screening is selected and you reject the call.

If the mailbox is a message taker, Amanda plays the system greeting when the specified 
greeting does not exist.
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To change the greeting:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select the greeting to be used from the Greeting drop-down list box.

The Maximum Length text box defines the maximum number of seconds allowed for 
each greeting. You cannot change this. It is under the control of the Amanda system 
administrator.

Controlling the Busy Greeting
You can use the system busy greeting or your own custom busy greeting (if your 
administrator has not locked the Custom Busy Greeting option).

To switch between the system and custom busy greetings:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select the On check box to use your custom busy greeting. Clear it to use the system 
busy greeting.

When this check box is selected, Amanda uses your custom busy greeting when your 
extension is busy. You can record the custom busy greeting only via the telephone. 
For more information, see Using Amanda@Work.Group/Windows Telephone Features.

When cleared, the system busy greeting is used. The system busy greeting allows the 
caller to hold for the extension by pressing *, which, in turn, causes Amanda to play 
the Busy-Hold music file (about 30 seconds of custom music) before trying the exten-
sion again. If the extension is still busy, Amanda changes the prompt, allowing the 
caller to continue holding, enter another extension, or leave a message. 

The Maximum Length text box defines the maximum number of seconds allowed for 
your custom busy greeting. You cannot change this. It is under the control of the 
Amanda system administrator.

NOTE: If the Extension text box in the General Mailbox Information dialog box 
indicates an unsupervised transfer (for example, 127H), calls cannot be 
placed on hold.

Playing a Greeting or Name and Extension Recording
You can listen to a greeting or your Name and Extension recording using either your 
telephone or your workstation’s sound card and speakers. (Which is used depends on the 
setting for Use Speakers. See “Setting Up Amanda Messenger,” earlier in this chapter, for 
more information.)

To play a greeting or your Name and Extension recording:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select Greeting, Name and Extension, or Custom Busy.
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3. If you select Greeting, you also select the greeting to be played from the Greeting 
drop-down combo box.

(You have up to seven personal greetings and the system greeting to choose from.)

4. Click Play.

Amanda Messenger plays the greeting or calls you on the telephone to play the greet-
ing.

Recording a Greeting or Name and Extension Recording
You can record greetings or your Name and Extension recording using your telephone or 
your workstation’s sound card. (Which is used depends on the setting for Use Speakers. 
See “Setting Up Amanda Messenger,” earlier in this chapter, for more information.) When 
recording on your workstation’s sound card, the sound can go to the sound card from a 
microphone, CD ROM drive, or an inline jack. 

To record a greeting or your Name and Extension recording:

1. On the Options menu, click Greetings…

2. The Greetings dialog box appears.

3. Select Greeting, Name and Extension, or Custom Busy.

4. If you select Greeting, you also select the greeting to be played from the Greeting 
drop-down combo box.

(You have up to seven personal greetings to choose from.)

5. Click Record.

6. Do one of the following:
• If you have checked the Use Microphones check box in the Workstation Options 

dialog box:
a. Start talking to the microphone, playing a CD, or whatever is appropriate. 
b. When you are done, click Stop. (The Record button changes to a Stop button.)

The Approve or Reject dialog box appears.
c. Click Review to listen to your recording.
d. Click Save to save it or Cancel to reject it. If you reject the recording, redo 

steps 3 and 4.

NOTE: For recordings made using the microphone, use the mixer to deter-
mine where the input is coming from. The mixer is usually a pro-
gram that comes with the sound card. It is also a standard multimedia 
application within Windows 95, 98, or NT called “Volume.”

• If the Use Microphones check box is unchecked, Amanda will call your extension 
and prompt you through the recording session.

See “Setting Up Amanda Messenger,” earlier in this chapter, for more information about 
workstation options.

Importing a Greeting or Name and Extension Recording
You can import a .WAV file for use as a greeting. For best results, use an 8-bit, mono 
.WAV file with a 11025kHz format. CD quality will also work. For a stereo .WAV file, you 
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can set the Stereo Import Conversion preference. See “Setting Up Amanda Messenger” 
and “Stereo Import Conversion,” earlier in this chapter for more information about 
converting .WAV files.

To import a .WAV file as a greeting or your Name and Extension recording:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select Greeting, Name and Extension, or Custom Busy.

3. If you select Greeting, you also select the greeting to be played from the Greeting 
drop-down combo box.

(You have up to seven personal greetings to choose from.)

4. Click Import….

The File Open dialog box appears.

5. Use the File Open dialog box to provide the path (drive, directory, and filename) for 
the .WAV file to be imported.

6. Click OK.

The Approve or Reject dialog box appears.

7. Click Review to listen to the .WAV file.

8. Click Save to save it or Cancel to reject it. If you reject it, you can redo steps 3 
through 7.

9. See “Setting Up Amanda Messenger,” earlier in this chapter, for more information 
about workstation options.

Naming an Greeting
To provide a name for a greeting:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select a greeting to be imported from the Greeting drop-down combo box. 

3. Click Edit Name….

The Greeting Name dialog box appears.

4. Type a name for the greeting in the text box. 

While you can type up to 50 characters in the text box, be aware that you can see only 
about 20 of those characters in the Greetings drop-down combo box.
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Miscellaneous
The next few sections cover general user information, managing guest mailboxes, and 
using Amanda Messenger’s menus, toolbar, and player controls.

Viewing General Mailbox Information
You can view, but not change, general information about your mailbox. 

To view this read-only information:
• On the Options menu, click Mailbox Info….

The General Mailbox Information dialog box displays the following:

• The two names used for you in the employee directory. Callers can type the first 
few digits of these names and be given your extension. Amanda Messenger dis-
plays this information at Directory Name 1 and Directory Name 2.

• The comment associated with your mailbox.

• The contents of your mailbox’s Extension text box. Usually this contains your 
extension. However, the administrator can use the Token Programming Language 
to program this text box.

 

Managing Guests
Your Amanda system administrator can allow you to create mailboxes for guests. For 
example, you may have a part time employee who needs to access voice mail for a few 
months.

To add a guest:

1. On the Options menu, click Guests…

The Guest List dialog box appears.

2. Click New. 

General Mailbox Information
Option Description

Directory Name 1 Amanda uses this information to build the employee directory (usually reached 
by dialing mailbox 411) automatically. 

Directory Name 2 Same as Directory Name 1. Amanda uses the second directory name to allow 
for an additional name, e.g., a last name or nickname. 

Comment Used by your Amanda system administrator to describe the mailbox.

Extension Controls how your incoming calls are processed. When a call accesses this mail-
box and Do Not Disturb is cleared, Amanda performs the programmed dial ac-
tions in this text box. Typically this text box contains the extension that Amanda 
should ring. 

Server Name The name of the Amanda Server to which you are logged on.
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The appropriate guest mailbox number appears in the guest list. 

To delete a guest:

1. On the Options menu, click Guests…

The Guest List dialog box appears.

2. Select the guest mailbox to be deleted.

3. Click Delete. 

Using the Menus
Amanda Messenger provides a menu bar with the following menus and options:

System menu

Edit menu

View menu

Log On Allows you log on to Amanda voice server after you have been dis-
connected for some reason. For example, the server may have become 
temporarily unavailable.

Stop Waiting Interrupts the action being performed. Use this command if communi-
cation between Amanda Messenger and Amanda voice server slows 
down significantly (due to network traffic, high levels of CPU activi-
ty, and so forth). 

Exit Allows you to terminate Amanda Messenger.

Undo Reverses the last editing action for the selected messages or compo-
nents.

Cut Moves the currently selected messages or components to the internal 
clipboard (not the Windows clipboard). The selected items replace the 
previous contents of the clipboard.

Copy Copies the currently selected messages or components to the internal 
clipboard. The selected items replace the previous contents of the clip-
board.

Paste Copies the messages or components currently stored in the internal 
clipboard to a message or Compose window.

Toolbar Displays or hides the toolbar.

Status Bar Displays or hides the status bar at the bottom of the window.

Player Controls Displays or hides the player controls and the slider.
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Messages menu
New Message Opens a new Compose window. 

Forward Opens a Compose window containing the components of the selected 
message. On the Messages menu, you click Record to add a compo-
nent that explains why you are forwarding the message, then click 
Send… to mail the contents of the Compose window.

Forward Immedi-
ately…

Forwards the current message to another mailbox without allowing 
you to edit the message.

Reply Replies to the current message if it was received from another mail-
box.

Send… Sends the current message to the specified mailboxes.

Import Message… Imports any .WAV file into a Compose window as a message compo-
nent. To send the message, use the Send… command on the Messages 
menu.

Show Components Allows you to view the components of a message. Every message con-
tains from 1 to 20 components.
NOTE:  You can also right-click a message to show its components. 

Edit Subject… Allows you to create a subject for the selected message. Use up to 50 
characters. The subject appears in the window in the Subject column.
NOTE:  You can also double-click a message’s subject column to edit 
the subject.

Save Moves the selected messages from the New Messages window or 
Trash Bin window to the Saved Messages window.
NOTE:  You can also drag the message to Saved Messages window.

Delete Moves the selected messages from the New Messages or Saved Mes-
sages window to the Trash Bin window.
NOTE:  You can also drag the message to Trash Bin window, click De-
lete on the toolbar, or press the Delete key.

Update Messages Moves messages you have heard or viewed from the New Messages 
window to the Saved Messages window.
NOTE: This is only available if the Auto Save New Messages feature 
is cleared.

Empty Trash Bin Permanently deletes all the messages from the Trash Bin window. 

Archive Message… Allows you to save a message as a .WAV file.
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Play menu
Fast Rewind Does one of the following:

Rewinds the voice message you are playing in approximately five-
second intervals 
Goes to the previous page of the fax message you are viewing

Pause Causes the current voice message to pause or restarts it after a pause.

Stop Stops the playing or recording of the current message.

Play Does one of the following:
• Plays the selected voice message
• Displays the selected fax message in a new Fax window. 

Each page is represented by a small thumb-nail-sized rect-
angle called a “thumbnail.” Click the thumbnail to magnify 
the page.

Record Records a message using your telephone or using your workstation, 
depending on the workstation options you have set. The message ap-
pears in a Compose window and can be sent to another mailbox using 
the Send… command on the Messages menu.

Fast Forward Does one of the following:
Fast forwards the voice message you are playing in approximately 
five-second intervals
Goes to the next page of the fax message you are viewing



Chapter 2: Using Amanda Messenger 47
Fax menu

Options menu

Window menu

View Fax Displays a fax message from Amanda voice server and displays it in 
Amanda Messenger.

Rotate Fax… Rotates or flips all the pages of a fax message. 

Zoom In Magnifies the display of the fax.

Zoom Out De-magnifies the display of the fax.

Import Fax Allows you to import the image file you are viewing as a component 
of a fax message.

Open… Opens an image file in TIFF, DCX, FAX and other image formats.

Save As… Saves the current fax message in TIFF or DCX format.

Print… Prints the current fax document.

Print Preview Displays the fax document as it would appear when printed.

Print Setup… Allows you to select and configure your printer.

Workstation
 Options…

Allows you to set workstation options. See “Setting Up Amanda Mes-
senger,” earlier in this chapter for more information.

Mailbox Info… Displays the current user information (name, extension, and so forth).

Security Code… Allows you to change your security code.

Basic Options… Displays the current settings for the Do Not Disturb, Call Screening, 
Identify Called Party, and Play Date & Time. You can change some of 
these options.

Greetings… Displays information about the Ring No Answer (RNA) and the Cus-
tom Busy greetings. You can change some of these options if they are 
not locked. You can also use this command to make recordings if your 
Amanda systems administrator allows you to record greetings and/or 
your name and extension recording.

Personal Lists… Allows you to create personal mailing lists. You can have up to 29 per-
sonal mailing lists, each of which can be identified by a name. They 
are numbered 1 to 8 and 10 to 30. The number 9 cannot be used for a 
mailing list.

Guests… Allows you to create a mailbox for a guest (if your Amanda system ad-
ministrator has configured your mailbox for guests).

Cascade Displays the open windows as a cascade of overlapping windows with 
the active window on top.

Tile Displays the open windows side-by-side.

Arrange Icons Aligns all minimized windows.
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Help menu

Using Toolbar Buttons

1 Trash Bin Selects the Trash Bin window as the active window.

2 Message 
Statistics

Selects the Message Statistics window as the active window.

3 Saved Messages Selects the Saved Messages window as the active window.

4 New Messages Selects the New Messages window as the active window.

Contents Displays the contents for online help.

Using Help Explains how to use online help.

About Messenger Displays copyright information and the version number for Amanda 
Messenger.

Opens a new Compose window. This is equivalent to the New Message command on the 
Messages menu.

Opens an image file to be viewed. This is equivalent to the Open… command on the Fax 
menu.

Moves the selected messages from the New Messages window to the Saved Messages 
window. This is equivalent to the Update Messages command on the Messages menu.

Removes the selected messages or components and stores them in an internal clipboard 
(not the Windows clipboard). This is equivalent to the Cut command on the Edit menu.

Copies the selected messages or components into the internal clipboard. This is equiva-
lent to the Copy command on the Edit menu.

Pastes the contents of the internal clipboard into the Compose window. This is equiva-
lent to the Paste command on the Edit menu.

Moves the selected messages from the New Messages or Saved Messages windows to 
the Trash Bin window. This is equivalent to the Delete command on the Messages menu.

Replies to the selected message. This is equivalent to the Message Reply command on 
the Messages menu.

Forwards the selected message to one or more mailboxes immediately (without letting 
you edit the message). This is equivalent to the Forward Immediately command on the 
Messages menu.

Sends the components in the active Compose window. This is equivalent to the Send… 
command on the Messages menu.

Prints the Fax message you are viewing. This is equivalent to the Print… command on 
the Fax menu.
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Using Player Controls

NOTE: When messages are played to you over the telephone, you control the 
playback of a message by pressing * (backwards) or # (forwards). 

Displays the help contents page. This is equivalent to the Contents command on the Help 
menu.

Enables Context Sensitive Help, allowing you to click on buttons, menus, or windows, 
to display help about them. 

Does one of the following:
• Goes to the previous page of the fax message you are viewing
• Rewinds the voice message you are playing in approximately five-second 

intervals
This is equivalent to the Fast Rewind command on the Play menu.

Causes the current voice message to pause or restarts it after a pause. This is 
equivalent to the Pause command on the Messages menu.

Stops the playing or recording of the current message. This is equivalent to the 
Stop command on the Play menu.

Does one of the following:
• Plays the selected voice message.
• Displays the selected fax messages in a new Fax window.
This is equivalent to the Play command on the Play menu.

Records a message using your telephone or your sound card, depending on the 
workstation options you have set. The message appears in a Compose window 
and can be sent to another mailbox using the Send… command on the Messages 
menu. 

This is equivalent to the Record command on the Play menu.

Does one of the following:
• Goes to the next page of the fax message you are viewing
• Fast forwards the voice message you are playing in approximately five-sec-

ond intervals
This is equivalent to the Fast Forward command on the Play menu.

This is used when the desktop PC is equipped with a sound card and a mouse. 
Rather than using the rewind and fast forward buttons, you drag the slider point-
er to a certain part of the current message while it is playing.
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Chapter 3:
Using Amanda Unified Messenger

Getting Started
Amanda Unified Messenger allows you to access voice messages in the same Microsoft 
mail application that you use for your e-mail. After installing Amanda Unified Messenger, 
your Microsoft e-mail application shows additional folders. The following example shows 
Windows Messaging with one Amanda folder for mailbox 147 and a second set for 
mailbox 1470. If you have more than one mailbox (on one or more Amanda voice 
servers), each mailbox needs its own set of folders.

The Current Messages folder for mailbox 147 currently contains a variety of unread, read, 
urgent, non-urgent, external and internal voice and fax mail messages. 

In the above figure, the Amanda server’s name is AMANDASERVER. Because this 
application runs on a workstation that uses the TCP/IP protocol to connect to the network, 
the server name is followed by the port number (in this case, 130). When the network 
protocol is NetBIOS/NetBEUI, the port number is replaced by the LANA number (0 or 1).

The figures in this chapter are examples of Windows Messaging. Other Microsoft mail 
applications, such as Outlook, will have a different appearance.

Logging On to an Amanda Voice Server
Unless you have asked Amanda to remember your password, you are occasionally asked 
to log on to the Amanda Voice Server:
• As you start your e-mail application
• As you access a voice mail folder
• After the server goes down and comes back up
• While mailing a voice mail message



52 Using Amanda@Work.Group/Windows Workstation Features
To log on to Amanda Voice Server:

1. When the Amanda Unified Messenger - Mailbox Logon dialog box appears, type 
your security code in the Security Code text box.

2. (Optional) Depending on the circumstances, this dialog box may have a Remember 
Security Code check box enabled.

Select the check box if you want to log on automatically in the future.

3. Click OK.

NOTE: The above figure shows the mailbox logon dialog box for a workstation 
that uses the TCP/IP network protocol. If you use the NetBIOS/NetBEUI 
protocol, you see a LANA number rather than a port number.

Adding to the Toolbar
Amanda Unified Messenger has several toolbar buttons that can be added to your e-mail 
application’s toolbar. Microsoft Outlook adds them for you, but with other applications, 
you must add them manually.

To add the Amanda Unified Messenger toolbar buttons to your e-mail application’s 
toolbar:

1. From the Tools menu, click Customize Toolbar….

The Customize Toolbar dialog box appears.

2. Select the last item in the Toolbar Buttons list box (on the right).

3. Scroll down until you locate the following buttons in the Available Buttons list box 
(on the left):
• Fast Rewind
• Play Voice Mail
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• Fast Forward
• Pause/Resume
• Stop
• Compose Voice Mail
• Amanda Mailbox Settings

4. Do one of the following to move each button to the Toolbar Buttons list box (and, 
therefore, to the toolbar):

•  Double-click each button.

• Select each button in turn, then click Add->.

5. Click Close.

TIP: You might want to add a Separator between your e-mail application’s 
last toolbar button and your Amanda Unified Messenger button and be-
tween Amanda Unified Messenger’s Stop and Compose Voice Mail but-
tons. The Separator is at the top of the Available Buttons list box.

Changing Your Security Code
You can change your security code using either Amanda Unified Messenger or your 
telephone. It is a good idea to change your security code immediately.

To change your security code:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

2. Click the Security Code tab.

3. Select the mailbox for which you are changing the security code from the Mailbox 
drop-down list box.

4. Type your security code in the Current Security Code text box.

5. Type the new code (up to 8 digits) in the New Security Code text box.

6. Retype the code in the Verify New Security Code text box.

Setting Sound Interface Options
An important part of getting started is setting sound interface options. These options 
determine whether Amanda calls your telephone extension to expect you to use your 
workstation’s microphone and speakers when you record and play greetings and 
messages.

To set sound interface and related start-up options:

1. Log on to Amanda Voice Server for all your mailboxes.

For example, you might log on as the e-mail application starts or as you click on an 
Amanda folder.
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2. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

The Amanda Mailbox Settings dialog box appears.

3. Click the Sound Interface tab. 

4. Select the mailbox for which you are setting sound interface options from the Mail-
box drop-down list box. 

Most people have only one mailbox and do not need to change the current setting.

5. From the Playing group box, select the Use Speakers or Use Telephone option button 
to indicate whether Amanda should play messages or greetings over the workstation’s 
speakers or call your extension.

6. From the Recording group box, select the Use Microphone or Use Telephone option 
button to indicate whether Amanda should record messages or greetings over the 
workstation’s microphone or call your extension.

7. If you are using your telephone for either playing or recording, type your telephone’s 
extension in the Extension text box.

8. Do one of the following:

• Select the Wait for Answer check box so that Amanda waits for a voice response 
before playing a message or asking you to record.

• Clear the Wait for Answer check box to have Amanda play or record as soon as 
you pick up your telephone receiver.

9. Repeat steps 4 through 8 for any other mailboxes that you have.

10. If you have more than one Amanda mailbox, click the Default Mailbox tab.

• Amanda needs to know which mailbox’s sound interface options to use when you 
create a message. So select that mailbox from the Mailbox drop-down list box.

NOTE: The default mailbox is not necessarily the mailbox that sends the 
new message. Messages are always sent from your mailbox on the 
recipient’s Amanda server. If you have more than one mailbox on 
that server, Amanda asks you to select one of them as the sender.

Managing Greetings
Greetings are recordings played by Amanda for a variety of uses. There are system 
greetings for:
• When you do not answer your telephone
• When your telephone is busy
• When your mailbox needs to be identified
• When you transfer a call

Because the system greetings are generic and impersonal, your Amanda system 
administrator usually allows you to record (or import .WAV files for) up to seven personal 
greetings, a custom busy greeting, and your name and extension recording. 
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Then, when you do not answer your telephone, Amanda plays your current greeting. 
When your extension is busy, Amanda plays your custom busy greeting. To identify you 
and/or your mailbox, Amanda plays your name and extension recording.

If you are screening call from your workstation, you control which greeting the caller 
hears as you transfer the call, put the caller on hold, or ask the caller to leave a message.

Sample Greetings
This section contains sample greetings for a variety of occasions. It is important that each 
greeting be as informative as possible.

Work-hours Greeting
When Amanda rings your extension and you do not answer, the caller hears a greeting. 
You can have up to seven of these greetings. For example, you can have a daytime 
greeting, an after-hours greeting, and a vacation or on-the-road greeting. Until you record 
a greeting, Amanda plays the system greeting, “Please leave a message for,” followed by 
your name and extension recording. (If you have not recorded the name and extension 
recording, Amanda plays your mailbox number.)

For example: “This is Chris. I’m away from my desk or on another line. You can bypass 
this greeting by pressing the # sign twice. To speak to someone else right now, enter that 
person’s extension or press 0 for assistance. If you leave me a detailed message at the tone, 
I’ll get back to you as soon as possible.”

These greetings can be manually selected by you or they can be scheduled by an 
administrator.

After-hours Greeting
Many Amanda administrators set up each mailbox so that greeting 1 plays for routine 
working hours and greeting 2 plays for after-hours calls. Here is an example:

“You have reached the office of Chris Wang at Homestead, Inc. after hours. No one at 
Homestead can answer your call right now. Leave a detailed message at the tone, or call 
during office hours: 10 A.M. to 6 P.M., Monday through Friday.”

Away-from-the-office Greetings
“Chris Wang of Homestead, Inc. will be out of town until Monday, May 5th. While I am 
gone, my associate, Matthew Lee, is handling all my business calls. Please call Matthew at 
Extension 557. I will be unable to check my messages until I return.”

“Chris Wang of Homestead, Inc. will be off-site until Monday, May 5th. While I am gone, 
my associate, Matthew Lee, is handling my business calls. Please call Matthew at 
Extension 557 or leave me a message. I will be checking my messages daily.”

Your Amanda administrator can copy your messages to both you and a coworker while 
you are on vacation or only to that coworker. (The administrator can stop the message 
copying when you return.) If someone else is getting your messages, you might want to 
use the following greeting:
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“Chris Wang of Homestead, Inc. will be out of town until Monday, May 5th. My associate, 
Matthew Lee, is handling all my business calls. Call Matthew at Extension 557 or leave 
him a detailed message at the tone.”

Custom Busy Greeting
By default, Amanda plays a standard busy greeting when your telephone is busy—unless 
you are screening calls.

If your Amanda system administrator allows custom busy greetings, you can create a more 
personalized busy greeting. When you turn the custom busy greeting on, callers hear it 
instead of the standard busy greeting.

For example:  “This is Chris. I’m talking to someone else at the moment. Press * to hold, 
enter another extension, or stay on the line to leave me a message.”

If you are screening calls, you can put a caller on hold and select either the custom busy 
greeting or one of your seven personal greetings.

Name and Extension Recording
The Name and Extension recording is just that—a recording of your name followed by 
your extension number. Amanda plays it:
• When a caller uses the employee directory to enter that user’s name
• As part of the system Ring No Answer (RNA) greeting. Amanda uses the system 

greeting when no personal greeting is recorded or allowed
• When one user replies to a message from another user
• When a user reviews his guest list

Example:  “Chris Wang. Extension 247.”

Creating Greetings
A greeting cannot exceed the length set by your Amanda system administrator. By default, 
this is 45 seconds. Parts of the following procedure can also be used to change the name of 
or listen to a greeting.

To create or change a greeting:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

2. Click the Greetings tab.

3. Select the mailbox for which you are recording the greeting from the Mailbox drop-
down list box.

4. Do one of the following:

• To create a personal greeting:
a. From the Edit Greetings group box, select the General option button.
b. Select a greeting (by name or number) from the drop-down list box.
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• To create and use a custom busy greeting:
a. Select the Custom Busy On check box.
b. From the Edit Greetings group box, select the Custom Busy option but-

ton.

• To create a name and extension recording:
- From the Edit Greetings group box, select the Name And Extension op-

tion button.

5. Click Edit.

The Edit Greeting dialog box appears.

6. If you selected General and a personal greeting, type a name for the greeting in the 
Greeting Name text box.
Use a name that will help you remember the greeting’s contents or purpose.

You can use up to 50 characters.

7. Record or import the greeting using one of the following procedures.

To record a greeting:
• Click Record.

If you use your telephone for recording:
a. Answer the telephone when Amanda rings your extension.

Amanda says, “Begin recording at the tone. Finish by pressing # or hanging 
up.” 

b. Follow Amanda’s instructions to complete the recording. Answer the tele-
phone.

If you use your workstation’s microphone for recording:
a. The Sound Recorder (sndrec32.exe) or some other application designated for 

recording on your workstation appears.

Use this application to record and save the greeting.
b. Return to the Edit Greeting dialog box.
c. (Optional) Click Play to review the greeting.

You may want to re-record.
d. Click OK until you return to where you started.

To import a greeting:

1. Click Import….

The Open dialog box appears.

2. Locate the appropriate .WAV file then click Open.

3. (Optional) Click Play to be sure you have the correct file.

4. Click OK until you return to where you started.
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Setting Your Current Greeting
When you do not answer your telephone, Amanda asks the caller to leave a message. 
Amanda plays your current greeting. You can record (or import .WAV files for) up to 
seven greetings. You can also use the system greeting as your current greeting.

If you are screening calls, you can select any of these greetings to be played as Amanda 
asks the caller to leave a message. However, the default is your current greeting.

You can change the current greeting using either Amanda Unified Messenger or your 
telephone. For example, you can change from your usual greeting to a vacation greeting or 
from a work-hours greeting to an after-hours greeting.

To select the current greeting:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

2. Click the Greetings tab.

3. Select the mailbox for which you are setting this option from the Mailbox drop-down 
list box.

4. Select a greeting from the Current Greeting drop-down list box.

5. Click Apply or OK.

Managing Voice Messages
You can create, listen to, forward, and reply to voice messages.

Creating a Voice Message
The following procedure assumes that you are using the Amanda Message form for 
composing messages. Be aware that Amanda ignores any text within the body of the 
message.

To create a voice message for another Amanda user:

1. Click Compose Voice Mail  from your Microsoft e-mail application’s Compose 
menu, Amanda Message menu, or toolbar.

The Amanda Message form appears.
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2. Click To….

The Address Book dialog box appears.

3. Select Addresses for the appropriate Amanda server and use the address book to 
select recipients.

You are not restricted to using Amanda users. For example, you can sent this message 
as e-mail to e-mail addresses.

4. (Optional) To send this message at a specific time in the future (rather than immedi-
ately), click Date….

The Future Delivery of Message dialog box appears.

To select the future date and time:
a. Select a month and year from the appropriate drop-down list boxes.
b. Select a day from the calendar.
c. Type each segment of the time (hours, minutes, AM/PM) separately and use 

the spin button to rotate to an appropriate setting for each.
d. Click OK.

5. (Optional) Type a subject for this message in the Subject text box.

6. (Optional) Select the Urgent check box to make this message urgent.
Urgent messages have exclamation marks in the Importance column (!) until they are 
read.

(To add the Importance column, use the Columns command on the e-mail applica-
tion’s View menu.)

7. (Optional) Select the Private check box to make this message private.
The word Private appears in the Sensitivity column and the message cannot be for-
warded.

(To add the Sensitivity column, use the Columns command on the e-mail applica-
tion’s View menu.)
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8. (Optional) Select the Read Receipt check box to have a Read Receipt message sent to 
you whenever a recipient reads this message (or marks it read).

9. To record your message, click Record  on the toolbar or Player menu.

Do one of the following:

• Speak clearly into your workstation’s microphone.

Then click Stop  on the toolbar or Player menu.

• Answer your extension and follow the recording instructions provided by 
Amanda.

10. To import a .WAV file as a voice component or a .TIF file as a fax component:

Click Import  on the toolbar or File menu. Then browse for and select the file.

NOTE: You can import other types of files, but the Amanda transport sends 
only .WAV and .TIF files. Other transports can send the other types 
to recipients who receive messages via that transport.

11. (Optional) To include text which can be sent via other transports, such as your e-mail 
application’s transport, do the following steps:
a. On the File menu, click Edit Body....

The Message Body dialog box appears.
b. Type the text message then click OK.

12. Click Send  on the toolbar or File menu.

Identifying the Application that Records Messages
Unlike most vendors with unified messaging that includes voice messaging, you can send 
a voice message or a voice response to a message from the e-mail application—as long as 
the message is destined for one or more Amanda mailboxes (and not an outside source). 
However, creating an Amanda voice message in the Microsoft e-mail application is easiest 
if you are not using WordMail as your e-mail editor.

Amanda Unified Messenger starts the application your workstation has set for opening 
.WAV files. This is usually Sound Recorder (sndrec32.exe), which is stored in the 
Windows folder (usually C:\WINDOWS).

To check this setting:

1. Open the My Computer window.

2. On the View menu, click Options….

The Options dialog box appears.

3. Click the File Types tab.

4. Find “WAVE Sound” or a similar name in the Registered File Types list box. Then 
click Edit….

The Edit File Type dialog box appears.
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5. Select Open from the Actions list box. Then click Edit….

The Editing Action For Type dialog box appears.

6. Notice what application appears in the Application Used To Perform Action text box.

Listening to Voice Messages
You will find incoming voice mail messages in your Amanda mailbox’s Current Messages 
folder. Deleted messages (until you log off) are in the Deleted Messages folder and can 
still be listened to.

If an outside call has a subject, it is the caller ID information captured using the “ccc” 
integration pattern or captured using the caller_id configuration parameter. For details, see 
Installing Amanda@Work.Group/Windows.)

To listen to a message:

1. Select the message from the list of messages in the folder.

2. Click Play  on the toolbar or Play Voice Mail on the Amanda Message menu.

To have more control over the message you are listening to:

1. Double-click the message from the list of messages in the folder.

The Amanda Message form displays each component. (If there are more than one 
voice components, the first voice component is a concatenation of all the other voice 
components.)

2. Select the first voice component.

3. Click Play  on the toolbar or Player menu.

4. You can adjust the Volume and so on from this dialog box, listen to individual compo-
nents, and so on.
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5. If you change the subject (for example, to remind yourself who placed an outside call 
or what the call was about): 

Click Save  on the toolbar or File menu.

TIP: Click Previous  and Next  to rotate from message to message.

Identifying the Application that Plays Messages
When you listen to a voice message, Amanda Unified Messenger starts the application 
your workstation has set for playing .WAV files. This is usually Sound Recorder 
(sndrec32.exe), but you might prefer Media Player (mplayer.exe). Both are stored in the 
Windows folder (usually C:\WINDOWS). 

To check this setting:

1. Open the My Computer window.

2. On the View menu, click Options….

The Options dialog box appears.

3. Click the File Types tab.

4. Find “WAVE Sound” or a similar name in the Registered File Types list box. Then 
click Edit….

The Edit File Type dialog box appears.

5. Select Play from the Actions list box. Then click Edit….

The Editing Action For Type dialog box appears.

6. Notice what application appears in the Application Used To Perform Action text box.

Viewing Fax Messages
Amanda voice server can send and receive fax documents as messages. A fax document 
has the fax icon  rather than the voice icon  beside it in the Current Messages folder. 
It is stored on your hard drive as a .TIF file.

To display a fax component in the viewer associated with .TIF files:
• Double-click the fax component in the Amanda Message form.

The application associated with .TIF files displays the fax.

The Wang Imaging application is a typical and reliable choice for displaying fax 
components.

Editing the Subject
From the Amanda Message form, you can edit the subject of the message. This is helpful 
in identifying calls you keep in your Current Messages folder, especially outside calls 
which can arrive without a subject. (If an outside call has a subject, it is the caller ID 
information captured using the “ccc” integration pattern or captured using the caller_id 
configuration parameter. For details, see Installing Amanda@Work.Group/Windows.)
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To edit the subject:

1. Type a new subject in the Subject text box.

2. Click Save Changes  on the toolbar or File menu. 

Archiving Message Components
From the Amanda Message form, you can archive a voice component as a .WAV file or a 
fax component as a .TIF file.

To archive a message component:

1. Select the component from the Amanda Message form.

2. Select Archive Component... from the File menu. 

3. Select a name and location for the new .WAV or .TIF file.

Replying to an Amanda Message
The following procedure assumes that you are using the Amanda Message form to reply to 
messages. Be aware that Amanda ignores any text within the body of the message.

To reply to a message from another Amanda user:

1. After listening to the message, click Reply on the toolbar.

An Amanda Message form displays the contents of the To and Subject boxes. The rest 
of the window is blank.

2. Follow the steps for creating a message. See “Creating a Voice Message” on page 58 
or, if you are using your e-mail application’s message form, see “Using the Your E-
mail Application’s Forward and Reply Form” on page 74.

Forwarding an Amanda Message
The following procedure assumes that you are using Amanda Message form to forward 
messages. Be aware that Amanda ignores any text within the body of the message.

To forward a message to another user’s mailbox:

1. After listening to the message, click Forward on the toolbar.

An Amanda Message form lists the components to be forwarded and displays the con-
tents of the Subject box. Everything else is blank.

2. Follow the steps for creating a message. For example, you should add an initial com-
ponent that explains that you are forwarding the message—and why.

See “Creating a Voice Message” on page 58 or, if you are using your e-mail applica-
tion’s message form, see “Using the Your E-mail Application’s Forward and Reply 
Form” on page 74.
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Using Do Not Disturb
When Do Not Disturb is on, Amanda immediately asks all of your callers to leave a 
message.

If your Amanda system administrator allows you to control the Do Not Disturb setting, 
you can turn it on and off using either Amanda Unified Messenger or your telephone. 
(Your Amanda system administrator can also change this feature.)

To turn Do Not Disturb on or off:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

2. On the Basic Options tab, select the mailbox for which you are setting this option 
from the Mailbox drop-down list box.

3. Select (or clear) the Do Not Disturb check box.

4. Click Apply or OK.

NOTE: If Do Not Disturb is on, no call screening occurs. Amanda immediately 
asks all callers to leave a message.

Identifying the Person Being Called
When two or more people share a telephone extension, Amanda can announce the name of 
the person being called. The people who answer that extension can reject calls intended 
for people who are not available. Amanda asks the callers of rejected calls to leave a 
message.

To identify the person being called, Amanda plays that person’s Name and Extension 
recording. (If there is no recording for that user, Amanda reads the digits in the user’s 
mailbox.)

This feature cannot be changed using the telephone. You can control the Identify Called 
Party setting using Amanda Unified Messenger. (Your Amanda system administrator can 
also change this feature.)

To turn Identify Called Party on or off:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

2. On the Basic Options tab, select the mailbox for which you are setting this option 
from the Mailbox drop-down list box.

3. Select (or clear) the Identify Called Party check box.

4. Click Apply or OK.
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NOTE: When a mailbox has both call screening and called party identification 
on, the modified_call_screening option controls whether Amanda an-
nounces only the name and extension of the called party or both that and 
the name and company of the caller. If the modified_call_screening op-
tion has been set to false, you hear both. Your Amanda system adminis-
trator controls this option.

Playing Date and Time of Message
By default, Amanda plays the date and time each message was received just before 
playing the message. You can shorten the time it takes to listen to your messages by 
turning this feature off. 

This feature cannot be changed using the telephone. You turn it on and off using Amanda 
Unified Messenger. (Your Amanda system administrator can also change this feature.)

To play (or stop playing) the date and time of each message:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

2. On the Basic Options tab, select the mailbox for which you are setting this option 
from the Mailbox drop-down list box.

3. Select (or clear) the Play Date/Time Of Message check box.

4. Click Apply or OK.

Deleting Messages
You can delete messages from the Current Messages folder or from the Amanda Message 
form. Deleted messages go into the Deleted Messages folder until you log off the Amanda 
server (usually by exiting your e-mail application). Until that time, you can “undelete” any 
of the deleted messages.

To delete a message:
• Do any one of the following:

- Select one or more messages from the Current Messages folder, press Delete, and 
confirm the deletion.

- Double-click the message in the Current Messages folder. 

From the Amanda Message form, click Delete  on the toolbar or File menu.

- Drag the messages to be deleted from the Current Messages folder to the Deleted 
Messages folder.

To permanently delete all messages:

1. From the Amanda Message form, click Delete  on the toolbar or File menu.

A warning message appears.

2. Confirm the deletion.
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To undelete a message:
• Do any one of the following:

- Double-click the message in the Deleted Messages folder. 
From the Amanda Message form, click Undelete on the File menu.

- Drag the messages to be undeleted from the Deleted Messages folder to the Cur-
rent Messages folder.

Screening Incoming Calls
You can screen incoming calls—either using your telephone, workstation, or both.

If you use your telephone, you can only screen calls that you answer. Amanda asks the 
caller for a name and company before dialing your extension. This name and company 
recording is played for you. You either accept or reject the call. Rejected callers are asked 
to leave a message.

If you use your workstation to screen calls, you can screen all calls or only those that 
arrive when your telephone is busy. You can:
• Connect the call to your telephone
• Put the caller on hold
• Have the caller leave a message
• Transfer the caller to another Amanda user

Most people use only their workstations to screen calls or only their telephones, depending 
on whether or not their workstations are equipped with sound cards, etc. Others use their 
telephones when their extensions are not busy and their workstations when their 
extensions are busy.

To keep the time a caller must wait to a minimum, you need to decide in advance what 
greetings you want callers to hear and what other Amanda users to transfer calls to. Also, 
if you use a call-screening timeout, you have only a few seconds to screen each call and 
take an appropriate action.

Setting Up Call Screening (for your telephone)
To screen calls over the telephone:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

The Amanda Mailbox Settings dialog box appears.

2. Select the mailbox for which you are setting call screening options from the Mailbox 
drop-down list box. 

Most people have only one mailbox and do not need to change the current setting.

3. On the Basic Options tab, make sure that the Do Not Disturb check box is cleared. 

When Do Not Disturb is on, Amanda does not screen calls. All callers are asked to 
leave a message immediately.

4. Click the Screen Calls tab.
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5. Select the Screen Calls Using Telephone check box.

6. Click Apply or OK.

Screening a Call (over your telephone)
To screen a call via the telephone:
• Amanda asks each caller for a name and company before dialing your telephone 

extension.

When you answer, you hear “Your caller is” followed by the name and company 
recording.

Then you hear, “To accept this call, press 1. To reject this call, press 2 and hang up. To 
transfer this call with notification, press 3. To transfer this call without notification, 
press 4.”

- If you press 1, the call is connected to your extension.

- If you press 2, the caller hears your current greeting and can leave a message.

- If you select 3 or 4, you hear “Enter the destination mailbox number.” and enter 
the digits in another Amanda user’s mailbox number.

If you select 3, the caller hears, “Your call is being transferred to” followed by 
the Name and Extension recording for the Amanda user to whom the call is being 
transferred.

NOTE: If you have selected both Screen Calls Using Telephone and Screen Calls 
Using Workstation, you should be aware of the following:

•If you selected the Only When Busy option button for workstation call screen-
ing, you have telephone screening when your extension is not busy and 
workstation screening when it is busy. 

•If you selected the Always option button for workstation call screening, work-
station call screen takes precedence over telephone call screening.

Setting Up Call Screening (for your workstation)
To set up call screening using your workstation:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

The Amanda Mailbox Settings dialog box appears.

2. Select the mailbox for which you are setting call screening options from the Mailbox 
drop-down list box. 

Most people have only one mailbox and do not need to change the current setting.

3. On the Basic Options tab, make sure that the Do Not Disturb check box is cleared. 

When Do Not Disturb is on, Amanda does not screen calls. All callers are asked to 
leave a message immediately.

4. Click the Screen Calls tab.

5. Select the Screen Calls Using Workstation check box.
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6. Decide when to screen calls by selecting either of the following:

• Select the Only When Busy option button to screen calls only when your tele-
phone is busy. This is similar to a “Call Waiting” feature.

• Select the Always option button to screen all calls.

7. Let Amanda know what to do if call screening times out before you select an action. 
Select one of the following:

• Have Amanda dial your extension by selecting the Route To Extension After 
Timeout option button.

• Have Amanda ask the caller to leave a message by selecting the Route To Voice 
Mail After Timeout option button.

• Have Amanda place the caller on indefinite hold by selecting the Keep On Hold 
option button.

8. Click Advanced....

The Advanced Call Screening dialog box appears.

9. If you want your workstation to beep when a new call is to be screened, select the 
Beep For New Active Call check box.

10. If you selected Keep On Hold as the timeout action, select Reminder Of Active Calls 
to have a message appear every 30 seconds reminding you that at least one call is still 
waiting for this mailbox.

11. (Optional) If you intend to transfer calls to other Amanda users, it is a good idea to 
create a personal transfer list. The transfer list should contain only the names of peo-
ple to whom you would transfer calls.
a. Select the Select From Personal Transfer List option button.
b. Click Edit List....

The Personal Transfer List dialog box appears.
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The Show Names From The drop-down list box defaults to the address book for 
the correct mailbox.

c. Use the Type Name Or Select From List text box or list box to locate the 
Amanda mailboxes to which you will transfer calls.

d. Double-click the mailbox (or select the mailbox and click To->) to add it to 
the Transfer List box.

NOTE: You can select a mailbox then click Properties to find out more 
about its owner.
Do not use the Find... button. It cannot search this address 
book.

e. Click OK to return to the Advanced Screen Calls dialog box.

12. Use the default timeout of 30 seconds or enter another number of seconds in the Call 
Waiting Timeout box.

The range is from 0 to 300 seconds (5 minutes).

13. When Amanda notifies you that you have a call waiting, you will probably be work-
ing in another application. If you use an input delay, the next key that you type ends 
up in that application rather than the call waiting dialog box. By default, the Call 
Input Delay box contains 5000 ms. You can decrease this delay by typing in a new 
number (0–5000) or using the spin button.

14. Click OK to return to the Screen Calls tab.

15. Click Apply or OK.

Screening a Call (using your workstation)
When a call is to be screened, the following window appears on your workstation:



70 Using Amanda@Work.Group/Windows Workstation Features
The Call List box has the following columns:

To screen a call on your workstation:

1. If you have speakers, click Play Name to hear the caller’s name and company.

2. Based on the caller’s description, you do one of the following:

• Connect to the caller:
a. If you are currently taking to a caller, end that call and hang up.
b.  On the Amanda Call Control for Unified Messenger window, click Con-

nect.
c. Answer your telephone when it rings.

TIP: To connect, you can also double-click the call or select the call 
and press Enter.

• Put the caller on hold:
a.  On the Amanda Call Control for Unified Messenger window, select a 

greeting for the caller from the drop-down list box beneath the Hold but-
ton.

Column Contents
Number The number given to the incoming call. 

When a call arrives, Amanda Unified Mes-
senger gives it the number 1 when there are 
no other calls in the Call List. Otherwise, the 
call is given the next available consecutive 
number.

Caller ID The mailbox number for a call from another 
Amanda user; the caller’s number for out-
side calls that provide Caller IDs.

Time Called The date and time the call arrived.
Elapsed Time The number of seconds that have passed 

since the call arrived.
Timeout The number of seconds left before the op-

portunity to take action on this call ends.
State A line of text indicating the current state of 

the call, such as:
New Call
On Hold
Transferred caller: xxx
Call went to voice mail
Connecting
Caller disconnected
Caller went to another mailbox
Caller disconnected
Connected
Lost connection
Sent to voice mail after server timeout
Caller recorded message
Caller elected not to leave message
Caller recording message

Description The text you entered after clicking the Set 
Description... button; this becomes part of 
the call history for later reference.



Chapter 3: Using Amanda Unified Messenger 71
The default is your custom busy greeting or, if you have no custom 
busy (or if custom busy is turned off), the default is the system busy 
greeting (“To leave a message, press *. To try another extension, en-
ter it now. To continue holding, please stay on the line.”).

b. Click Hold.
c. (Optional) Click Set Description....

The Enter Call Description dialog box appears.

• Type the name of the caller or some other descriptive text in the 
Description text box.
This description is for future reference.

d. After you end your current call, select the number for this call, then click 
Connect.

• Have the caller leave a message:
a.  On the Amanda Call Control for Unified Messenger window, select a 

greeting for the caller from the drop-down list box beneath the Take Mes-
sage button.
The default is your current greeting or, if you have not recorded greet-
ings, the system greeting (“Please leave a message for” followed by your 
Name and Extension recording).

b. Click Take Message.
c. To listen to the message being left by your caller, click Listen In.
d. When you are through listening, click Stop Listening.

NOTE: While the caller is leaving a message, you can still click Con-
nect, Hold, or Transfer.

• Transfer the caller to another Amanda user:
a. On the Amanda Call Control for Unified Messenger window, select a 

greeting for the caller from the drop-down list box beneath the Transfer 
button or use the System Transfer greeting (“Your call is being trans-
ferred to” followed by the other user’s Name and Extension recording).

b. Click To....
Either the system list or your personal transfer list appears.

c. Select a mailbox then click OK.
d. Click Transfer.

NOTE: The mailbox you select appears in the To... button as the default 
transfer mailbox for your next call. For example, instead of 
reading “To...”, the button reads “To 142” or “To James Egan.” 
When you click Transfer, the call goes directly to the specified 
mailbox. To reset the To... button, click it. Then you can make 
a selection from the system list or your personal transfer list 
once more.

The Amanda Call Control for Unified Messenger window remains on your monitor’s 
screen after you have finished screening calls. Click Close if you prefer not to see the 
window.

TIP: Click the Question Mark button on the call control window, then click on 
each button or list to learn more about it.

NOTE: You can add a description (by clicking Set Description...) at any time. 
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Using the Call History Folder
For each call that you screen on your workstation, an entry appears in the Call History 
folder. As shown in the next figure, the Amanda Message - Call History form displays 
information about the call, such as the date and time of the call, the action taken, and any 
description of the call you have entered.

You can click Play Name and Company Recording to hear the name and company of the 
caller. You can click Open Caller’s Message... to review any message left as a result of the 
call. For example, if you connected yourself to this caller, no message was left and the 
Open Caller’s Message... button is disabled.

If you forward or reply to a call history message, the name and company recording is 
mailed. If the call history message is forwarded as e-mail, the text of the Description box 
is also sent. A message left by a caller is never forwarded this way.

Editing the Description
From the Amanda Message - Call History window, you can edit the call history message’s 
description. This is helpful in identifying individual calls.

To edit the description:

1. Type a new description in the Description text box.

2. Click Save Changes  on the toolbar or File menu. 
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Creating Personal Distribution Lists
You can send messages to Amanda users that are on one of your 29 possible personal 
distribution or mailing lists or the 29 possible system distribution lists (created by the 
Amanda system administrator). In the Amanda Address book, these are listed with either 
their default names (Personal List 1 to Personal List 8; Personal List 10 to Personal List 
30; System List 1 to System List 8; System List 10 to System List 30) or the names that 
you and your Amanda administrator have given them. They always appear in bold face 
type which makes them easier to locate. They also have a two-person icon indicating that 
they are distribution lists.

When you add a mailbox to a list, the Amanda system confirms that:
• The new mailbox shares at least one group with you
• The new mailbox (or its copy-to mailbox) can receive mail

Otherwise the mailbox cannot be added to your mailing list. For more information about 
groups, see Administering Amanda@Work.Group/Windows.

You can rename a personal distribution list to indicate what addresses it contains and edit 
its contents. However, you cannot delete a personal distribution list from Amanda Unified 
Messenger.

To edit a personal distribution list:

1. From the Tools menu or toolbar, click Address Book.

The Address Book window appears.

2. From the Show Names From drop-down list box, select the appropriate Amanda 
address book.

3. To review or edit a personal distribution list, do one of the following:

• Double-click the list

• Select the list then, on the File menu, click Properties
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The Personal List Properties dialog box appears.

4. Type a descriptive name for this list in the List Name text box.

5. Click Edit List....

The Personal List dialog box appears.

6. Select the users to be part of this list.

7. Click OK until you return to the main window.

Reading Mailbox Information
Amanda Unified Messenger displays:
• The name of the Amanda voice server that manages your mailbox
• The names (usually your first and last) supplied by the system administrator to 

identify you
• The contents of both the Extension field and Comment field (or Set Name field) 

associated with your mailbox.

To read your mailbox information:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

2. Click the General tab.

3. Select the mailbox to be reviewed from the Mailbox drop-down list box.

Using the Your E-mail Application’s Forward and 
Reply Form

By default, Amanda displays the Amanda Message form when you forward voice 
messages or reply to them. You can use the form provided by your e-mail application for 
forwarding and replying to e-mail if you prefer. You can still select Amanda users as 
recipients.
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To stop using (or return to using) the Amanda Message form:

1. Click Amanda Mailbox Settings  on the toolbar, the Amanda Message menu, or 
the Tools menu.

2. On the Basic Options tab, select the mailbox for which you are setting this option 
from the Mailbox drop-down list box.

3. Clear (or select) the Use The Amanda Message Form For Forwarding And Replying 
check box.

4. Click Apply or OK.

To record voice attachments when using your e-mail application’s forms, use the Record 
Attachments command on the form’s Insert menu. If you prefer, you can add the Record 
Attachments button to the form’s toolbar.

To add the Record Attachments button to the window or form used to create 
messages in your e-mail application:

1. From the Tools menu on the form for forwarding and replying, click Customize 
Toolbar….

The Customize Toolbar dialog box appears.

2. Select the last item in the Toolbar Buttons list box (on the right).

3. Select the Record Attachment button from the Available Buttons list box (on the left).

4. Click Add-> to add it to the Toolbar Buttons list box (and, therefore, to the toolbar).

5. Click Close.

TIP: You can double-click the Record Attachment button to immediately add 
it to the Toolbar Buttons list box.

To forward or reply to a voice message:

1. Click Forward or Reply on the toolbar.

Your e-mail application’s message window appears.

2. Address the message using your Amanda Address book for the appropriate Amanda 
voice server.

NOTE: You can type the name or mailbox number of the sender, but it will 
match the first addressee in any mailbox with that name or number. 
For example, typing Steve will match the first Steve in the first of 
your address books (not necessarily an Amanda Address Book). 
However typing 147 is unlikely to match anything other than an 
Amanda mailbox. If you have only one Amanda Address Book, this 
is an easy way to address messages.

3. Type a subject for the message.

4. Click Record Attachment  on the toolbar or Insert menu.

The Sound Recorder (sndrec32.exe) or a similar application appears.
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NOTE: If you use WordMail, you must start Sound Recorder or a similar ap-
plication, create a .WAV file as a message, then attach that file using 
the File command on the Insert menu.

5. Operate Sound Recorder to create a message.

(Start recording, speak into the microphone, stop recording.)

6. Use any of the following properties from the e-mail applications message window:

• Importance High (for a priority message)

• Sensitivity Private (for a private message)

• Read Receipt (to receive a message that your message was heard)

The following figure shows the New Message Properties dialog box from which 
these can be set in Windows Messaging. 

Importance High and Read Receipt are also toolbar buttons. 

7. On the File menu or toolbar in the message window, click Send.

To send a fax message:
• Create or locate a .TIF file, then attach that file using the File command on the In-

sert menu.

Turning Off WordMail as the Editor
If WordMail is your e-mail editor, the Record Attachment  button is not on the toolbar 
or Insert menu. You must start Sound Recorder (sndrec32.exe) or a similar application, 
create a .WAV file as a message, then attach that file using the File command on the Insert 
menu. Record Attachment conveniently does all that for you.



Chapter 3: Using Amanda Unified Messenger 77
To turn off WordMail as the editor (if only while using an Amanda folder):

1. From the e-mail application’s main window, on the Compose menu, click WordMail 
Options.

The WordMail Options dialog box appears.

2. Clear the Enable WordMail As Email Editor check box.

3. Click Close.
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Chapter 4:
Using Amanda Dialer

Getting Started
Amanda Dialer dials telephone numbers from a variety of Windows applications on your 
workstation. You select the number to be dialed. Amanda Dialer dials it for you and 
notifies you when the call is ready.

Starting and Exiting Amanda Dialer
When you start Amanda Dialer, you log on to the Amanda voice server.

To use Amanda Dialer:

1. Click the Amanda Dialer icon. In Windows 95, you can select Amanda Dialer from 
the Start menu. 

The Dialer Log On dialog box appears.

2. Click Network Settings…. 

The Network Settings dialog box appears. 

3. Type the server name in the Server Name text box. 

See your system administrator for the correct name.

4. Click OK.

The Dialer Log On dialog box reappears.

5. Type your mailbox in the Mailbox text box.

Your mailbox is probably the same as your extension number, but it doesn’t have to 
be. Check with your system administrator to be sure.

6. Type your security code in the Security Code text box.

7. Click OK.

If this is your first time using Amanda Dialer, the Amanda Dialer - Extension dialog 
box appears. It displays your mailbox.

8. If your mailbox and your extension are different numbers, type your extension num-
ber in Your Extension text box.

9. Click OK.
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The Amanda Dialer button appears in the upper right corner of the screen. You can 
drag it to a more convenient location.

To exit Amanda Dialer:
• Right-click the dialing button, then select Exit from the context menu.

Setting Options
Amanda Dialer can add your outside line prefix, long distance access code, and 
international access code to the number to be dialed automatically if you set the Amanda 
Dialer options.

To set up Amanda Dialer using the Dialing Options dialog box:

1. Right-click the Amanda Dialer button.

The Amanda Dialer context menu appears.

2. Click Dialing Options….

The Dialing Options dialog box appears.

3. If the telephone extension in Your Extension text box is incorrect, type the correct 
extension (not your mailbox—although they may be the same).

4. Type the number of digits (2-5 digits) in your telephone extension in the Extension 
Maximum Digits text box. 
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5. By default Monitor Call Progress is cleared so that Amanda performs an unsupervised 
transfer. After the number is dialed, Amanda calls your extension then releases the 
port. (Your telephone switching system must be able to transfer an outside ringing 
line to an internal extension.)

Select Monitor Call Progress to have Amanda perform supervised transfers. During a 
supervised transfer, Amanda monitors the call for a connection status (answer, busy, 
or RNA). Once the status is determined, Amanda either calls your extension or dis-
plays a message on the screen explaining the connection status. If the call is 
answered, the called party hears, “Your caller is,” followed by your Name and Exten-
sion recording.

6. Only if you selected Monitor Call Progress do you need to fill in the Number of Rings 
text box. Type the number of rings after which Amanda decides that the called party is 
not answering. The default is 4 rings.

7. Type the number of digits in a local number in the Local Number Maximum Digits 
text box.

8. The default is 7 because in the United States, local telephone numbers are seven digits 
in length. 

9. Type the area code of the site from which you are calling in the Local Area Code text 
box. 

10. Type the digits necessary to get an outside line in the Outside Line Prefix text box. 
The default is 9 followed by a comma (for a two-second pause).

11. Select the International Access Code check box if numbers longer than the usual long 
distance call are international. (The usual long distance call contains the number of 
digits in a local call plus the number of digits in an area code) If cleared, Amanda 
Dialer ignores International Access Code.

12. If you selected International Access Code, type that code in the text box. The default 
is 011, the international access code for the United States.

To restore the default settings:
• Click Defaults.
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Dialing Numbers from Windows Applications
You can use Amanda Dialer with Windows 3.11, 95, 98 or NT. Most Windows programs 
are compatible with Amanda Dialer because they use Ctrl+C to copy selected text to the 
Windows clipboard. If you have a problem using Amanda Dialer from any application, 
copy the telephone number to the Windows clipboard before clicking the Amanda Dialer 
button.

With Windows 3.11
Once the floating dialing button is visible, you can dial a telephone number. 

To dial a number:

1. Select the telephone number to be dialed from the active window in any Windows 
application.

2. Click the Amanda Dialer button. 

The number should appear in the Amanda Dialer - Dial Number dialog box. 

3. If it is incorrect, edit the number. When it is correct, click Dial. 

Amanda dials the displayed number.

With Windows 95, 98 or NT
Once the floating dialing button is visible, you can dial a telephone number. 

To dial a number:

1. Click the Amanda Dialer button. 

2. Select the telephone number to be dialed from the active window in any Windows 
application.

3. Right-click the selected number.

The number should appear in the Number to Dial dialog box. 

4. If it is correct, select Dial. 

Amanda dials the displayed number.

NOTE: If right-clicking the selected number displays a context menu and the 
Amanda Dialer - Dial Number dialog box does not appear, move the 
mouse to another location before right-clicking. For example, in Sched-
ule Plus, you can right-click just outside the text box that displays the se-
lected number. If the problem persists, copy the telephone number to the 
Windows clipboard before clicking the Amanda Dialer button.
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Redialing a Number
Dialer saves the last four telephone numbers that you dialed. 

To redial a previously dialed number:

1. Right-click the Amanda Dialer button.

The Amanda Dialer context menu displays up to four recently dialed numbers. (In 
parentheses is the number of times each of these numbers has been dialed during this 
Dialer session.)

2. Click the number to be redialed.
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Chapter 5:
Using Amanda Fax

Introducing Amanda Fax
You can use Amanda Fax (a 16-bit application) or Amanda Fax 32 (a 32-bit application) 
from any Windows application that has a Print command. You can send documents, 
spreadsheets, pictures, or anything else that the application can print. You can:
• Fax an item to another location via Amanda voice server’s fax modem
• Create a fax message to be mailed to users on your Amanda system
• Save the item as a file that can be:

• Sent later as a fax via Amanda voice server’s fax modem

For example, if you copy this file to Amanda voice server using Amanda Moni-
tor, you can fax it to callers. See the one-call and two-call faxback sections in 
Installing Amanda@Work.Group/Windows.

• Imported as a fax message
• (Only available with the 32-bit application) You can save the fax as a TIFF image 

file containing multiple pages (if the fax is longer than one image page)

If you are faxing items via Amanda voice server, you need the following:
• A fax modem attached to and properly configured for use with your Amanda voice 

server (for more information see your Amanda system administrator or Installing 
Amanda@Work.Group/Windows).

In all cases, you need the following:
• Amanda Fax or Amanda Fax 32 installed on each workstation from which faxes 

will originate. Amanda Fax is a 16-bit application and Amanda Fax 32 is a 32-bit 
application.

The directions for using each of these two applications is slightly different.

Caveats
Try some test items from any Windows application to be used for fax purposes before 
faxing items to others. For example, in Word for Windows, for best readability, print 
documents that have the page size 8 1/2 by 11 and portrait as the orientation.

Using the 32-bit Amanda Fax
The 32-bit version of Amanda Fax is the most popular and, therefore, this chapter 
describes it first. For a description of the 16-bit Amanda Fax application, see “Using the 
16-bit Amanda Fax” on page 91.
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Sending a Fax
You can send documents, etc. from Windows applications as faxes using the Amanda 
voice server’s fax modem. You can fax whatever a Windows application can print, for 
example, all or part of a document or spread sheet. 

NOTE: When you submit a fax request, Amanda sends a special message back 
to your mailbox when the fax is either successfully sent or determined to 
be a failure. On the telephone, Amanda says one of the following:

• Fax <phone number faxed to> sent.

• Fax <phone number faxed to> deleted because the remote phone 
number was incorrect.

In Amanda Messenger, the fax status appears in the Subject field.

To send a fax from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax 32 then click OK.

The Amanda Fax 32 dialog box appears.

3. From the Action drop-down list box, select Queue Fax To Host.
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4. Type your mailbox in the Mailbox text box.

Your mailbox is probably the same as your extension number, but it doesn’t have to 
be. Check with your Amanda system administrator to be sure.

5. Type the fax number to receive this fax in the Phone # text box.

You may need to start with 9 for an outside line.

6. Type your security code in the Password text box.

(This is the same security code that you use to access Amanda over the telephone.)

7. (Optional) Select the Remember Password check box to avoid typing in your security 
code the next time you send a fax.

8. Type the name of the Amanda voice server which controls your mailbox.

See your Amanda administrator if you need help with the server name.

9. Click OK.

Saving a Fax as a TIFF File
You can save documents, etc. from Windows applications as TIFF files of one or more 
pages. TIFF files are image files and can be viewed from and inserted into documents 
created with a number of different applications, such as Microsoft Paint.

To save the current document as a TIFF file from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax 32 then click OK.

3. When the Amanda Fax 32 dialog box appears, select Save As TIFF File from the 
Action drop-down list box.



88 Using Amanda@Work.Group/Windows Workstation Features
The File Save As dialog box appears.

4. Provide a name and location for the new file.

The default extension is, of course, .TIF.

5. Click OK.

Saving a Fax as a Fax File
You can save documents, etc. from a Windows application as fax files. The saved files can 
be copied to the Amanda voice server (using Amanda Monitor) or imported by Amanda 
Messenger as fax messages.

To save the current document as a TIFF file from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax 32 then click OK.

3. When the Amanda Fax 32 dialog box appears, select Save As Fax File from the 
Action drop-down list box.
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The File Save As dialog box appears.

4. Provide a name and location for the new file.

The default extension is .FAX, but you can use another extension. (The information is 
stored in The Amanda Company’s proprietary format, regardless of the extension.)

5. Click OK.

Sending a Fax Message
You can send documents, etc. from Windows applications as fax messages to other users 
of your Amanda system. This requires you to use Amanda Messenger as well as Amanda 
Fax.

To send a document as a fax message from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax 32 then click OK.

3. When the Amanda Fax 32 dialog box appears, select Send To Messenger from the 
Action drop-down list box.
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4. Type your Amanda Messenger mailbox in the Mailbox text box.

Your mailbox is probably the same as your extension number, but it doesn’t have to 
be. Check with your Amanda system administrator to be sure.

5. Click OK.

Amanda Messenger starts (if it isn’t already running) and the fax appears as a compo-
nent in a new Compose window.

6. To take a look at the fax before you send it, double-click the fax component in the 
Compose window.

A Fax window appears which displays the pages of the fax as thumbnails, small rect-
angles about the size of a thumb nail. You can click the thumbnail for a better view of 
it and use the commands on the Fax menu to manipulate it.

7. When you are ready to send the fax, make the Compose window active. Then, on the 
Messages menu, click Send… to send this fax to one or more mailboxes and lists. 

After you send the message, you can stay in Messenger or return to the Amanda Fax 
dialog or the Windows application.
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Using the 16-bit Amanda Fax
You can use Amanda Fax to send documents, etc. as faxes, save them as fax files to be 
used by the Amanda voice server, or send them as fax messages to Amanda Messenger.

Sending a Fax
You can send documents, etc. from Windows applications as faxes using the Amanda 
voice server’s fax modem. You can fax whatever a Windows application can print, for 
example, all or part of a document or spread sheet. 

To send a fax from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax then click OK.

The Amanda Fax dialog box appears.

3. Click Fax Out….

The Amanda Fax Logon dialog box appears so Amanda Fax can verify that you have 
a mailbox and security code on the Amanda voice server to be used.
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4. (Optional—if the default server name is the correct name)
Indicate what Amanda voice server to use:
a. Click Network Settings…. 

The Network Settings dialog box appears.

b. Type the server name in the Server Name text box. 

See your system administrator for the correct name.
c. Click OK.

The Amanda Fax Logon dialog box reappears.

5. Type your mailbox in the Mailbox text box.

Your mailbox is probably the same as your extension number, but it doesn’t have to 
be. Check with your system administrator to be sure.

6. Type your security code in the Security Code text box.

(This is the same security code that you use to access Amanda over the telephone.)

7. Click OK.

The Fax Number dialog box appears.

8. Indicate where to send this fax by doing one of the following:

• Type the fax number in the text portion of the Fax Number drop-down combo 
box using a maximum of 65 characters. (It may be necessary to prefix the fax 
number with an access code, such as 9 followed by a comma for an outside line.)

• Select a previously used fax number from the list portion of the drop-down 
combo box.

9. Click OK.

The Amanda Fax dialog reappears.

10. Click Close or perform another fax operation.

Saving a Fax as a Fax File
You can save documents, etc. from a Windows application as fax files. The saved files can 
be copied to the Amanda voice server (using Amanda Monitor) or imported by Amanda 
Messenger as fax messages.
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To save an item as a fax file from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax then click OK.

The Amanda Fax dialog box appears.

3. Click Save as Fax File….

The File Save As dialog box appears.

4. Provide a name and location for the new file.

The default extension is .FAX, but you can use another extension. (The information is 
stored in The Amanda Company’s proprietary format, regardless of the extension.)

5. Click OK.

The Amanda Fax dialog box reappears.

6. Click Close or perform another fax operation.

Sending a Fax Message
You can send documents, etc. from Windows applications as fax messages to other users 
of your Amanda system. This requires you to use Amanda Messenger as well as Amanda 
Fax.

To send a fax message from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax then click OK.

The Amanda Fax dialog box appears.
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3. Click Send to Messenger….

The Messenger Identification dialog box appears.

4. Type your mailbox in the Messenger Mailbox text box then click OK.

If Amanda Messenger is running, the fax appears as a component of the active Com-
pose window. If no Compose window is active, a new Compose window is opened to 
receive this component. Go to Step 6.

5. If Amanda Messenger is not running, the Messenger Logon dialog box appears and 
you must log on to Amanda Messenger as you normally would:
a. (Optional—if the default server name is the correct name)

Indicate what Amanda voice server to use:
1) Click Network Settings…. 
2) Type the server name in the Server Name text box. 

See your system administrator for the correct name.
3) Click OK.

The Messenger Logon dialog box reappears.
b. Type your mailbox in the Mailbox text box. 

Your mailbox is probably the same as your extension number, but it doesn’t have 
to be. Check with your system administrator to be sure. 

c. Type your security code in the Security Code text box. 

(This is the same security code that you use to access Amanda over the tele-
phone.) 

d. Click OK. 

Messenger starts (if it isn’t already running) and the fax appears as a component 
in a new Compose window.

6. To take a look at the fax before you send it, double-click the fax component in the 
Compose window.

A Fax window appears which displays the pages of the fax as thumbnails, small rect-
angles about the size of a thumb nail. You can click the thumbnail for a better view of 
it and use the commands on the Fax menu to manipulate it.

7. When you are ready to send the fax, make the Compose window active. Then, on the 
Messages menu, click Send… to send this fax to one or more mailboxes and lists. 

After you send the message, you can stay in Messenger or return to the Amanda Fax 
dialog or the Windows application.

8. The Amanda Fax dialog box is still open.

9. Click Close or perform another fax operation.

NOTE: When you submit a fax request, Amanda sends a special message back 
to your mailbox when the fax is either successfully sent or determined to 
be a failure. On the telephone, Amanda says one of the following:

• Fax <phone number faxed to> sent.

• Fax <phone number faxed to> deleted because the remote phone 
number was incorrect.

In Amanda Messenger, the fax status appears in the Subject field.
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